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Introducing Phase2 
PHASE2 is a 2-dimensional plastic finite element program for calculating stresses and 
displacements around underground openings, and can be used to solve a wide range of 
mining and civil engineering problems, involving: 
 

• PLANE STRAIN or AXISYMMETRY 
• ELASTIC or PLASTIC materials 
• STAGED excavations (up to 50 stages) 
• MULTIPLE MATERIALS 
• SUPPORT (bolts / shotcrete) 
• CONSTANT or GRAVITY field stress 
• JOINTED rock 
• GROUNDWATER (include pore pressure in analysis) 

 
The PHASE2 program consists of 3 program modules: MODEL, COMPUTE and 
INTERPRET. 
 
You are now using the MODEL module. 
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Phase2 Modeler 
The PHASE2 program consists of 3 program modules: 
 

• MODEL 
• COMPUTE 
• INTERPRET 

 
You are now using the MODEL module.  MODEL is the pre-processing module used for 
entering and editing the model boundaries, support, in-situ stresses, boundary conditions, 
material properties, and creating the finite element mesh. 
 
MODEL, COMPUTE and INTERPRET will each run as standalone programs. They also 
interact with each other as illustrated in the schematic below: 
 

M I

C
 

 
• COMPUTE and INTERPRET can both be started from within MODEL. 
• COMPUTE must be run on a file before results can be analyzed with INTERPRET (red 

arrow) 
• MODEL can be started from INTERPRET. 
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Starting a New Project 
To start creating a new project with PHASE2, select the New option from the toolbar or the 
File menu. A new blank project window will be opened, in which you can start creating your 
model. 
 
There are two things you will generally need to do before you start entering your model 
boundaries: 
 

1. Select Project Settings from the toolbar or the File menu. Various analysis and model 
parameters are set in the Project Settings dialog. In particular, if your model is 
staged you should set the number of stages before you proceed further, as this affects 
the availability and operation of certain modeling options. 

2. Select Limits from the View menu, to set the initial limits of your drawing region. 
 
See the Quick Start Tutorial for a lesson on how to create a simple model with PHASE2. 
 
Tips 

• When the PHASE2 modeler is first started, you will always be presented with a new 
blank project window named "Project1". You can immediately start creating a model in 
this window. If you are not starting a new project, then simply close this window, and 
Open the file you want to work with.  
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Opening a File 
To open an existing PHASE2 file: 
 

1. Select Open from the toolbar or the File menu.  
2. You will see a Windows Open file dialog. PHASE2 files have a .fea filename extension 

(.fea stands for Finite Element Analysis). Select the .fea file you want to work with, 
and it will be opened in PHASE2. 

 
Opening Multiple Files 
As PHASE2 is a fully MDI (multiple document interface) application, any number of files can 
be simultaneously open for editing. 
 
Furthermore, any number of windows (views) can be opened for each file, using the New 
Window option in the Window menu.  
 

Saving a File 
A PHASE2 input file (.FEA filename extension) can be saved at any point during the 
modeling process.  
 
However, note that you will not be able to run COMPUTE on an .FEA file, unless the finite 
element mesh exists. 
 
If you only wish to save the boundaries of a model, then you can use the Export DXF option 
for this purpose. 
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Project Settings 
The Project Settings option, available in the toolbar or the File menu, allows the user to 
set various important modeling and analysis parameters. The Project Settings should 
always be chosen at the start of the modeling, since some of the settings affect the 
availability and operation of certain Model options. 
 

• In particular, the Number of Stages, Analysis Type, and Groundwater Method, should 
always be chosen at the start of modeling. 

• Other settings, such as Tolerance and Solver Type, can be changed at any point during 
the modeling, up until the time you run Compute , since these are strictly analysis 
parameters. 

 
Project Name 
The user can enter a Project Name, if desired. The Project Name appears in the Info Viewer 
listing. 
 
Number of Stages 
PHASE2 allows multi-stage finite element analysis of excavations in up to 50 separate 
stages. 
 
The default Number of Stages is one (ie. a single stage model). Enter any number between 2 
and 50 to allow multi-stage modeling and analysis. You should set the Number of Stages 
before you start to create your model, since several of the Model options operate differently 
depending on whether your model is single stage (Number of Stages = 1) or multi-stage 
(Number of Stages = 2 to 50). 
 
Analysis Type 
Two types of models can be created and analyzed in PHASE2: 
 

• A Plane Strain model assumes that the excavations are of infinite length in the out-of-
plane direction, and therefore the strain in the out-of-plane direction is zero. Most 
PHASE2 models will use a Plane Strain analysis. 

• An Axisymmetric analysis allows the user to analyze a 3-dimensional model which is 
rotationally symmetric about an axis (for example, the end of a circular tunnel). 
Although the input is 2-dimensional, the analysis results apply to the 3-dimensional 
problem.  

 
For more information, see the Plane Strain and Axisymmetric Analysis topics. 
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Maximum Number of Iterations 
The Maximum Number of Iterations controls the maximum number of iterations allowed in 
each Load Step. The default value is 500. 
 
Tolerance 
The (local) Tolerance value controls the allowable unbalanced nodal force at any single node. 
This value is the fraction of the Euclidian norm of the load vector for a given Load Step. The 
suggested value is .01 to .001. The default is .001. 
 
Note: for an ELASTIC analysis (ie. all materials are elastic), the Tolerance is not used since 
the solution is "exact". The Tolerance is relevant for PLASTIC materials, and you may wish 
to try different values – larger values (eg. .01) will speed up the solution time for problems 
which have trouble converging, and smaller values (eg. .0001) may give a more accurate 
solution, however, this will vary depending on the problem. 
 
Load Steps 
By default, the Number of Load Steps used by COMPUTE at each stage is automatically 
determined by PHASE2 (Number of Load Steps = Auto). The user can force COMPUTE to 
use a pre-determined Number of Load Steps, by entering a number from 1 to 30 in the 
Number of Load Steps option of Project Settings. 
 
Note the following: 

• When a user-defined Number of Load Steps is entered, this number will be used AT 
EACH STAGE of calculation.  

• When Number of Load Steps = Auto, the number of Load Steps used at each stage will 
not necessarily be the same. 

 
In general it is recommended that the user leave Number of Load Steps = Auto. Entering a 
user-defined Number of Load Steps is recommended for advanced users only. 
 
Solver Type 
This option determines how COMPUTE solves the matrix representing the system of 
equations defined by your model. Three methods are available: 
 

• Gaussian Elimination 

• Conjugate Gradient Iteration 

• Pre-Conditioned Conjugate Gradient Iteration 

 
The default method is Gaussian Elimination, but note that: 
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• For solving large problems, you may have to use one of the Conjugate Gradient solution 
techniques, since disk swapping (swapping between disk and memory during the 
analysis) is enabled with the Conjugate Gradient methods. Disk swapping is NOT 
available with Gaussian Elimination. 

• If all your materials are ELASTIC, the solution time will be faster with the Conjugate 
Gradient techniques. 

 
Groundwater 
As of PHASE2 version 5.0, the effect of groundwater can be included in the finite element 
analysis, and effective stress results can be obtained. Two different methods of defining 
Groundwater conditions are available: 
 

• Piezometric Lines  

• Water Pressure Grids 

 
Piezometric Lines 
If the Groundwater Method = Piezometric Lines, then the user may define one or more 
Piezometric Lines in order to define the groundwater pore pressure conditions for each soil 
type. Note: 

• Piezometric Lines are created with the Add Piezometric Line option. 
• After Piezometric Lines are created, they must then be assigned to the desired 

materials, using the Define Groundwater Properties option. 
See the Add Piezometric Line and Define Groundwater Properties topics for details. 
 
Water Pressure Grids 
There are three Groundwater Method options for defining a Water Pressure Grid in PHASE2: 

• Grid (Total Head) 

• Grid (Pressure Head) 

• Grid (Pore Pressure) 

If the Groundwater Method is set to one of these three options, a Water Pressure Grid can be 
created or read from a file, using the Water Pressure Grid option in the Boundaries 
menu. See the Water Pressure Grid topic for details. 
 
If one of the three Water Pressure Grid options is selected, then the user may also select the 
method of interpolation, used to obtain the water pressure at any point in the soil, from the 
grid data. Two interpolation methods are available: 
 
Thin-Plate Spline 
The Thin-Plate Spline solution uses an infinite thin elastic plate under tension, to obtain a 
solution which allows interpolation of data at any point, based on the data at the grid points. 
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Reference: Franke, Richard. Thin plate splines with tension, Computer Aided Geometric 
Design 2 (1985) 87 – 95, North-Holland. 
 
Chugh’s Method 
This is an interpolation method based on finding the nearest water pressure grid point, in 
each of the four quadrants with origin centered at the point where the interpolation is 
required. A plane is then fit through each combination of three quadrant grid points, and an 
interpolation is performed for each plane. This results in four interpolations, which are then 
averaged to obtain the final interpolated value at the desired point. 
Reference: Chugh, A.K. Pore Water Pressure in Natural Slopes, International Journal for 
Numerical and Analytical Methods in Geomechanics, Vol. 5, 449 – 454 (1981), John Wiley & 
Sons Ltd. 
 
Pore Fluid Unit Weight 

• The calculated pore pressure at any given point, is directly proportional to the Pore 
Fluid Unit Weight, if the Groundwater Method = Piezometric Lines, Grid (Total Head) 
or Grid (Pressure Head).  

• The Pore Fluid Unit Weight does NOT enter into the pore pressure calculations, if the 
Groundwater Method = Grid (Pore Pressure), since in this case, pore pressures are 
determined directly from the grid data. 
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Plane Strain Analysis 
In the Project Settings dialog, two different Analysis Types are available, Plane Strain or 
Axisymmetric analysis. 
 
Plane Strain assumes that the excavation(s) are of infinite length normal to the plane section 
of the analysis. In most cases you will be performing a Plane Strain analysis. In a Plane 
Strain analysis PHASE2 calculates: 
 

• the major and minor in-plane principal stresses (Sigma 1 and Sigma 3), 
• the out-of-plane principal stress (Sigma Z) 
• in-plane displacements and strains 

 
By definition, the out-of-plane displacement is ZERO in a Plane Strain analysis. 
 
In practice, as the out-of-plane excavation dimension becomes less than five times the largest 
cross-sectional dimension, the stress changes calculated assuming Plane Strain conditions 
begin to show some exaggeration because the stress flow around the "ends" of the excavation 
is not taken into account. This exaggeration becomes more pronounced as the out-of-plane 
dimension approaches the same magnitude as the in-plane dimensions. 
 
If you have an excavation which is rotationally symmetric about an axis, then you can use 
the Axisymmetric modeling option, instead of Plane Strain. 
 

 



 

 14 

Axisymmetric Analysis 
In the Project Settings dialog, two different types of analysis can be selected, Plane Strain or 
Axisymmetric analysis. 
 
The Axisymmetric option allows you to analyze a 3-dimensional excavation which is 
rotationally symmetric about an axis. The input is 2-dimensional, but because of the 
rotational symmetry, you are in fact analyzing a symmetric 3-dimensional problem.  
 
A typical use of the Axisymmetric modeling option, is to analyze the stress state around the 
end of a circular tunnel. 
 
See the PHASE2 User’s Guide for a tutorial on AXISYMMETRIC modeling. 
 
Some simple Axisymmetric models are shown below. Only an EXTERNAL boundary is 
required, the shape of the EXTERNAL boundary implicitly defines the excavation. 
 
       
EXAMPLES of AXISYMMETRIC models -- If the left edge of each mesh is coincident with 
the X = 0 axis, then the model on the left represents a SPHERE and the model on the right 
represents a CYLINDER, in three dimensions. 
 
The mathematical formulation of an Axisymmetric finite element is actually similar to Plane 
Strain (and plane stress) problems. By symmetry, the two components of displacement in 
any plane section of the excavation through its axis of symmetry define completely the state 
of strain, and therefore, the state of stress. Instead of analyzing a unit out-of-plane depth, 
the analysis is performed on a unit radian. 
 
Restrictions on Axisymmetric Modeling 
There are several restrictions on the use of Axisymmetric modeling in PHASE2: 
 

1. The Field Stress must be axisymmetric ie. aligned in the axial and radial directions. 
Out-of-plane (or circumferential) field stress exists, but is equal to the radial stress, and 
cannot be independently varied. 

2. Cannot be used with GROUNDWATER (ie. Piezometric lines or Water Pressure Grid) 
3. Cannot be used with BOLTS (however LINERS are permitted). 
4. Cannot be used with JOINTS . 
5. All materials must have ISOTROPIC elastic properties (cannot use transversely 

isotropic or orthotropic elastic properties). 
6. The true orientation of your excavation is arbitrary (ie. it could be horizontal, vertical or 

at any inclination). However, for the purposes of the PHASE2 Axisymmetric analysis, 
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you will have to map your coordinates so that the model is symmetric about the X = 0 
axis (ie. a vertical axis located at X = 0), since all finite elements are rotated about this 
axis. 

7. To form a closed excavation, one edge of your mesh must be coincident with the X = 0 
(vertical) axis. If this is not the case, the excavation will be "open-ended". 

8. All other PHASE2 modeling options can be used with an Axisymmetric model, however, 
always keep in mind the nature of an Axisymmetric model (for example, when defining 
loads, boundary conditions, etc.) 
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Info Viewer 
The Info Viewer option provides a convenient summary of model information in its own 
view. Use the scroll bar on the right to scroll through the information. The Info Viewer 
behaves like any other view in PHASE2 – ie. it can be re-sized, tiled, minimized, maximized 
and closed. 
 
The Info Viewer option is available in both the PHASE2 MODEL and PHASE2 
INTERPRET programs.  
 

• In the PHASE2 MODEL program, only model information is listed. 
• In the PHASE2 INTERPRET program, model information is listed, as well as analysis 

information. 
• In both PHASE2 MODEL and PHASE2 INTERPRET, the Info Viewer is available in 

the toolbar or the File menu. 
 
The Info Viewer information can be saved by the user in a variety of ways, for including in 
reports, documents, etc. 
 
Copy to Clipboard 
The Info Viewer information can be copied to the clipboard using the Copy option in the 
toolbar or the Edit menu, or by right-clicking in the view and selecting Copy. From the 
clipboard, the information can be pasted into word processing programs for report writing.  
 
Save to File 
The Info Viewer information can be saved to a text file (*.TXT) or rich-text format file 
(*.RTF), by right-clicking in the view and selecting the desired Save As option, or by 
selecting the desired Save As option from the File menu, while the Info Viewer is the 
active view.  
Note: a rich-text format file preserves the text formatting that you see in the Info Viewer as 
it is displayed in PHASE2. A plain text file saves the text only, with no formatting. 
 
Printing 
The Info Viewer information can also be sent directly to your printer using the Print option 
in the File menu. 
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Compute 
The PHASE2 finite element analysis engine (FEAWIN.EXE) can be launched from the 
PHASE2 modeler by selecting the Compute button on the toolbar, or from the File menu. 
The Compute option is not enabled unless the finite element mesh exists. 
 

• If you have started a new project and you select Compute before saving the file, you 
will first see the Save As dialog. After you give the project a name and save the file, the 
analysis will be run. 

• If you are working on an existing file, the file will automatically be saved and the 
analysis will be run when you select Compute. 

• If for some reason you need to abort the analysis after selecting Compute, select the 
Abort button on the Compute dialog, and the analysis will be terminated. 

• The PHASE2 analysis engine (FEAWIN.EXE) can be run as a standalone program. The 
Compute button in Model is simply a convenient shortcut. 

 
Output Files 
After a PHASE2 analysis of your input .FEA file, the following output files are created: 
 
.R?? The .R?? files are the main PHASE2 output files, 

containing all of the nodal stress and displacement 
data. The ?? characters represent the stage numbers, 
which can range from 01 to 50. For example, a single 
stage model will only have an .R01 file. A two stage 
model will have .R01 and .R02 files, etc. 

.X?? The .X?? files contain bolt data, if bolts are being used 
for support. The ?? characters represent the stage (01 to 
50) 

.U?? The .U?? files contain strain data. The ?? characters 
represent the stage (01 to 50) 

.LOG A .LOG file is always created, which summarizes a few 
important analysis parameters (number of iterations, 
run time, etc.) for each stage. The .LOG file can be 
opened in the PHASE2 Interpreter, or it can be viewed 
with any ASCII text editor. 

 
All PHASE2 input and output files are ASCII files which can be viewed with an ASCII text 
editor. 
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Interpret 
The PHASE2 Interpreter can be launched from the PHASE2 Modeler by selecting the 
Interpret button on the toolbar, or from the File menu. The Interpret button is enabled as 
soon as the finite element mesh is generated, however, you must of course run Compute on a 
file before you can look at the results in Interpret. 
 
When Interpret is started from Model, the active file in Model will automatically be opened 
in Interpret. Furthermore, the user can return back to Model using the Model button in 
Interpret. This allows the user to switch back and forth between Model and Interpret, so that 
they can edit a model, re-compute and view new results. 
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Import DXF 
Boundaries and bolts can be imported into PHASE2 from a DXF file (AutoCAD Drawing 
Exchange File), using the Import DXF option in the Import sub-menu of the File menu. 
This allows users to digitize drawings in AutoCAD, for example, and import them into 
PHASE2. 
 
Importing boundaries or support in DXF format is equivalent to adding boundaries or 
support using the options within PHASE2 (Add Excavation , Add External , Add Material , 
Add Stage , Add Joint , Pattern Bolt / Spot Bolt ). That is, all the same rules apply, and 
boundaries/bolts will be automatically checked for validity, intersected if necessary, etc. 
 
To import boundaries / bolts from a DXF file: 
 

1. Select Import DXF from the Import sub-menu of the File menu. 
2. In the DXF Options dialog you will see, select the entities you would like to import, 

using the checkboxes provided. 
3. Select the Import button, and you will see an Open File dialog. Select the required DXF 

file and select OK, and all entities you selected in the DXF Options dialog will be 
imported into the current PHASE2 document. 

 
Tips 

• Bolts cannot be imported unless the mesh exists.  
• If boundaries already exist in your current PHASE2 document when you use Import 

DXF, you may see warning message(s) if the imported boundaries are not compatible 
with the existing boundaries. For example, if you try to import an excavation which is 
outside of the existing external boundary. So always be aware of what is in your DXF 
file when you try to import entities. 

• If you are using AutoCAD to create DXF files for import into PHASE2, use the following 
conventions for layering and entity type: 

 
PHASE2 Object LAYER AutoCAD Entity 

Type 
Excavation 
Boundaries 

EXCAVATION
S 

Closed LINE / PLINE 

External Boundary EXTERNAL Closed LINE / PLINE 
Material Boundaries MATERIALS LINE / PLINE 
Stage Boundaries STAGES LINE / PLINE 
Joint Boundaries JOINTS LINE / PLINE 
Piezometric Lines PIEZO LINE / PLINE 
Bolts BOLTS LINE 
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Import Properties 
The Import Properties option allows the user to import properties (ie. material, bolt, liner, 
joint) from one PHASE2 file into another PHASE2 file. This allows the user to simply read 
properties from another file, without having to re-define properties each time they are 
needed.  
 
To import properties: 
 

1. Select Import Properties from the Import sub-menu of the Files menu. 
2. You will see the Properties Import dialog. This dialog allows the user to read only a 

certain subset of properties (ie. you may want SUPPORT properties, but not 
MATERIAL properties to be loaded into your current model). Select the desired data 
you wish to read, using the checkboxes, and select the Import button. 

3. You will then see an Open File dialog, allowing you to select the PHASE2 file from 
which to import properties. Open a file, and only the data selected in the Properties 
Import dialog will be read into your current document.  
NOTE: you may also import properties from PHASE2 version 4 property files, see below 
for details.  

4. After importing properties, you should verify that the correct properties have been read. 
Select a Define option (eg. Define Materials), and check that the properties in the 
dialog are the ones you wanted. 

 
PHASE2 version 4 Property Files 
In PHASE2 version 4, properties could be stored in special "property files" which had a .PRP 
filename extension. PHASE2 version 5 no longer supports the creation of .PRP files, since 
properties are now read directly from other PHASE2 (*.FEA) model files. However, .PRP 
files which were created with PHASE2 version 4 can still be read by PHASE2 version 5. In 
step 3 above, if you select Files of Type in the Open File dialog, you will be able to select .PRP 
files for import. 
 
Default Properties File – DEFAULTPROPERTIES.FEA 
You can create your own custom DEFAULT property file, which will always be loaded at 
program startup, by naming a PHASE2 file phase2defaultproperties.fea.  
 
If you create such a file, then the properties in this file will always be the DEFAULT 
properties which are loaded at program startup. This allows you to always have your favorite 
DEFAULT properties automatically loaded, without the need to use the Import Properties 
option. 
 
To re-instate the original PHASE2 default properties, you will have to delete (or rename) the 
phase2defaultproperties.fea file. If PHASE2 does not find this file at program startup, it 
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will load the original program defaults (ie. the default properties when you installed the 
program). 
 
Note that the phase2defaultproperties.fea file does NOT exist when you install PHASE2, 
it must be created by the user. 
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Export DXF 
PHASE2 boundaries and bolts can be exported to a DXF file (AutoCAD Drawing Exchange 
File), using the Export DXF option in the Export sub-menu of the File menu. 
 
To export boundaries/bolts to a DXF file: 
 

1. Select Export DXF from the Export sub-menu of the File menu. 
2. In the DXF Options dialog you will see, select the entities you would like to export, 

using the checkboxes provided. 
3. Select the Export button, and you will see a Save As dialog. Type in a filename, or select 

an existing filename. Select OK and all entities you selected in the DXF Options dialog 
will be saved to a DXF file with the name you entered. 

 
Tips 

• The Export DXF option can be used for exporting your model geometry into AutoCAD.  
• It can also be useful for saving boundaries / bolts for future import back into PHASE2 

using the Import DXF option. For example, you could save different bolt patterns in 
different DXF files. This could allow you to save many different bolt patterns for the 
same model, without having to save complete PHASE2 files. This could save disk space 
for very large files, and/or save the trouble of re-creating bolt patterns each time they 
are needed.  
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Exporting Images 
Various options are available for exporting image files in PHASE2. 
 
Export Image File 
The Export Image File option in the Export sub-menu of the File menu, allows the user to 
save the current view directly to one of four image file formats: 
 
JPEG (*.jpg) 
Windows Bitmap (*.bmp) 
Windows Enhanced Metafile (*.emf) 
Windows Metafile (*.wmf) 
 
Copy to Clipboard 
The current view can also be copied to the Windows clipboard using the Copy option in the 
Edit menu. From the clipboard, images can be pasted directly into word or image processing 
applications. See the Copy topic for details. 
 
NOTE: 

• To capture the entire screen to the Windows clipboard, you can use the Print Screen key 
on your keyboard. This is useful if you wish to capture multiple views in a single image, 
for example after tiling the views. 

• Pressing the Alt + Print Screen keys together will capture the application window only 
to the clipboard (useful if the PHASE2 program window is not maximized on your 
desktop). 
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Undo / Redo 
Undo 
The Undo option in the Edit menu allows you to undo changes to your model, for example: 

• adding / deleting a boundary 
• adding / deleting vertices 
• adding / deleting loads 
• changing material properties 
• etc 

Any number of changes can be reversed with Undo, starting with the most recent change 
and progressing backwards. 
 
Redo 
The Redo option in the Edit menu allows you to restore changes that you have undone with 
the Undo option. Redo will restore each use of the Undo option, starting with the most 
recent Undo and progressing backwards. Redo is only enabled if at least one Undo action 
has been performed. 
 
Undo and Redo are also available as toolbar buttons. 
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Copy 
The Copy option in the Edit menu allows you to copy the contents of the active view to the 
Windows clipboard. This can then be pasted into word-processing or paint programs, for 
further editing, report writing etc. 
 
Note:  

• The window border and title bar will NOT be copied, only the contents of the window. 
• The highlighted dark blue title bar indicates the active view. 
• If the Info Viewer is the active view, then the Copy option will copy the Info Viewer 

text to the clipboard. By default, ALL text in the Info Viewer will be copied to the 
clipboard. If you only want selected text, then first highlight the desired text with the 
mouse, and then select Copy. 

• See the Exporting Images topic for further information about saving images with 
PHASE2. 
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Limits 
The first step in any computer-aided design process is setting the drawing limits of the 
region so that the limits encompass the model geometry. The Limits option allows the user 
to do this. 
 

1. Select Limits from the View menu. 
2. Enter the X and Y coordinates of the lower left (Minimum X Y) and upper right 

(Maximum X Y) corners of the drawing region you would like to start working with. 
3. Press OK and the limits of the view will be updated to encompass the limits you have 

just entered. 
4. The actual limits will in general not be exactly the ones you entered, unless the box you 

have defined is exactly the same "shape" as the current view. In any case, the limits will 
always encompass the coordinates you entered (ie. it will never be smaller than the 
limits you entered). 

 
The Limits option is intended for use when initially creating the model. After a model has 
been created, the Zoom and Pan options can be used to adjust the viewing region with 
respect to the model, it is not necessary to use the Limits option. 
 
Once your limits are set, you are ready to start creating your model!  
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Zoom All 
The Zoom All option will automatically scale the model in the active view, so that all parts 
of the model are visible.  
 
Zoom All is useful for quickly restoring the whole model to view, if you have been using the 
other Zoom options (eg. Zoom In , Zoom Out , Zoom Window , Zoom Mouse , Zoom Excavation 
), or the Pan option. 
 
Zoom All is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar, 
• The default right-click menu, 
• The F2 function key. 
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Zoom In 
Zoom In will increase the magnification of the model in the active view, so that the new 
view area is 90% of the old view area. 
 
Zoom In is useful when you quickly want to zoom in on the model. You can keep selecting 
Zoom In as many times as necessary. If you want to zoom in on a specific area of interest, 
then use the Zoom Window option, rather than Zoom In. 
 
Zoom In is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar, 
• The F5 function key, 
• The Home key. 
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Zoom Out 
Zoom Out decreases the magnification of the model in the active view, so that the new view 
area is ~111% of the old view area. 
 
Zoom Out is useful when you quickly want to zoom out on the model. You can keep selecting 
Zoom Out as many times as necessary. If you want to restore the entire model to view, then 
you may want to use the Zoom All option, rather than Zoom Out. 
 
Zoom Out is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar, 
• The F4 function key, 
• The End key. 

 



 

 30 

Zoom Window 
Use Zoom Window to quickly zoom in to any specific area of the model. To use Zoom 
Window: 
 

1. Select the Zoom Window option. 
2. Use the left mouse button to select one corner of the area you wish to zoom in on. When 

you move the mouse, you will notice a rectangular window opening up. 
3. Use the left mouse button to select the opposite corner of the area to be zoomed. 
4. The view will then be updated, scaling the area that you have just selected to fit in the 

view.  The view will always be updated to show the ENTIRE window you have selected, 
even if it is not the same "shape" as the view. 

 
Tips 

• The corners of the zoom window can be entered as x,y coordinate pairs in the prompt 
line at the bottom right of the screen. This is useful if you wish to zoom into exactly the 
same region on different views, or on different models, for example. 

• If you are not satisfied with the result of using Zoom Window, you can always try to 
improve the view by using Zoom In , Zoom Out , Zoom Mouse , Pan , or using Zoom 
Window again. If all else fails, select Zoom All and start over! 

• You may find Zoom Excavation a useful alternative to Zoom Window, for 
automatically zooming in to your excavation(s). 

• To cancel the Zoom Window option (before you have entered the second window 
corner) use the Escape key, or right-click and select Cancel. 

 
Zoom Window is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar,  
• The default right-click menu. 
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Zoom Mouse 
The Zoom Mouse option (a.k.a. Mouse Zooming, dynamic zooming) is another convenient 
method for zooming in or out. To use Zoom Mouse: 
 

1. Select the Zoom Mouse option. 
2. Press and hold the left mouse button. 
3. Move the mouse up (to zoom in) or down (to zoom out) while keeping the left mouse 

button pressed. 
4. Release the left mouse button when the zoom is satisfactory. 
5. To exit the Zoom Mouse option, use the Escape key, or right-click and select Done. 

 
Tips 

• If you have a mouse with a wheel, you can quickly zoom in or out by moving the wheel 
forward or backward. 

• Note that Zoom Mouse always zooms the model about the center of the view. To zoom 
in to a specific area of interest, you may find it necessary to use Zoom Window rather 
than Zoom Mouse, unless the area you wish to zoom is already at the center of the 
view. 

 
Zoom Mouse is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar,  
• The default right-click menu. 
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Zoom Excavation 
Zoom Excavation is a useful shortcut for quickly zooming in to the excavation(s) in your 
model, without having to use the Zoom Window option. 
 
If your model consists of multiple excavations, Zoom Excavation will take into account the 
combined extent of all excavations. 
 
Zoom Excavation is available in: 
 

• The Zoom sub-menu of the View menu, 
• The Zoom toolbar, 
• The F8 function key. 
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Pan 
The Pan option allows you to move the model in any direction within the view. To Pan: 
 

1. Select the Pan option. 
2. Press and hold the left mouse button. 
3. Move the mouse around while keeping the left mouse button pressed. You will see that 

the model moves around with the cursor. 
4. Release the left mouse button when the view is satisfactory. 
5. You can repeat steps 2 – 4, until you are satisfied with the results. 
6. To exit the Pan option, use the Escape key, or right-click and select Done. 

 
Tips 

• If you have a 3-button mouse (or a mouse wheel) you can quickly pan by pressing and 
holding the middle button of the mouse, while moving the mouse. 

• You will find Pan a very useful and frequently used option. For example, it is very 
handy for making adjustments to the model position in the view after using the Zoom 
Window option, if the view is not quite where you intended. 

• Since the Pan option operates as a "mode", you can use Zoom In , Zoom Out , Zoom All , 
or Zoom Excavation , without leaving Pan mode. This is a useful shortcut for 
manipulating the view. 

• A Pan can also be defined by entering x-y coordinates for a base point and a second 
point in the prompt line. Using the mouse is recommended, but if you want to Pan by an 
exact amount, then you may find the keyboard entry useful (for example, to pan 5 
meters to the left, you could enter a base point of 0 , 0 and a second point of –5 , 0.) 

• The arrow keys (up / down / left / right) can also be used to pan 
 
Pan is available in: 
 

• The View menu, 
• The Zoom toolbar,  
• The default right-click menu. 
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Display Options 
The Display Options dialog can be used to display: 
 
Element Numbers  
Shrink Elements  
Node Numbers  
Restraints  
Forces  
Tractions  
 
The Display Options dialog works a little differently than a regular dialog. It is known as a 
"roll-up" dialog, and can be left up on the screen while performing other tasks. 
 
To use the dialog: 
1. Make your selections using the checkboxes. 
2. The Apply button will apply your selections to the active view, without closing the 
dialog.  
3. The Done button will apply your selections to the active view AND close the dialog. 
4. The "arrow" button in the upper right corner can be used to "roll-up" or "roll-down" 
the dialog, without closing it. This allows the user to minimize/maximize the dialog, to keep 
it out of the way when not needed. 
5. The X button in the upper right corner will close the dialog and cancel any selections. 
The X button will NOT cancel selections if they have already been applied using the Apply 
button. 
 
Tip 
A "roll-up" dialog is useful when working with multiple views, since the user can apply 
different options to different views using the Apply button, without closing the dialog. 
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Element Numbers 
Element Numbers will display the number of each finite element, as used in the PHASE2 
data files (the .FEA and .R?? files). 
 
When Element Numbers are displayed, they will overlap in dense regions of the mesh. This 
is normal, use the Zoom Window option to zoom in and make numbers readable. 
 
The display of Element Numbers can be useful if you are performing a detailed inspection or 
troubleshooting of the mesh. 
 
Shrink Elements 

The Shrink Elements option will "shrink" each finite element such that common sides 
between elements are drawn twice and offset from each other. This allows the user to check 
the integrity of the mesh if a problem is suspected. Or it can simply be used as an alternate 
way of displaying the mesh. 
 
Node Numbers 
This option will display the node numbers of the finite element mesh, as used in the PHASE2 
data files (the .FEA and .R?? files). 
 
When Node Numbers are displayed, they will overlap in dense regions of the mesh. This is 
normal, use the Zoom Window option to zoom in and make numbers readable. 
 
The display of Node Numbers can be useful if you are performing a detailed inspection or 
troubleshooting of the mesh. 
 
Note: you may notice that the node numbering begins at 4. Don’t worry, this is correct, and is 
due to the automatic meshing process, which requires 4 nodes located "outside" of the 
external boundary. These 4 "invisible" nodes are numbered 0, 1, 2, 3. 
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Restraints 
The Restraints option will display all nodal restraints applied to the model.  
 

• A node restrained in both the X and Y directions will display a triangular "pinned" 
symbol. 

• A node restrained in the X direction only, will display a vertical "roller" symbol. 
• A node restrained in the Y direction only, will display a horizontal "roller" symbol. 
• Non-zero "displacement" values will be represented by an arrow and the displacement 

magnitudes in the X and Y direction. 
 
In addition, if Infinite Elements are being used to model the external boundary conditions, 
the Restraints option will show this by displaying arrows along the nodes of the external 
boundary where the infinite elements are applied. 
 
Forces 

The Forces option will display all nodal forces you have applied to the model with the Add 
Nodal Forces option in the Forces sub-menu of the Loading menu. An arrow symbol and a 
numerical value represent the direction and magnitude. 
 
Note: the Forces option also displays springs added with the Add Springs option. 
 
If not already toggled on, Forces and Springs are automatically toggled on anytime the user 
adds or deletes forces or springs with the Add Nodal Forces, Delete Nodal Forces, Add 
Springs, or Delete Springs options. 
 
Tractions 

The Tractions option will display all tractions you have applied to the model. Arrows 
represent the direction of the tractions and the numerical magnitude is also displayed. 
 
The Scale Factor allows you to scale the size of the traction arrows on the screen. The scale 
factor is for display purposes only, and does not affect the magnitude of the traction loading. 
 
The display of Tractions is automatically toggled on, anytime the user adds or deletes 
tractions. 
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Grid 
The Grid option allows the user to display a grid of points or lines over the model. To turn 
the grid on or off, select Grid from the View menu, and toggle the Grid Status. Grid settings 
can also be changed (Grid Style, Spacing, and Colour) in this dialog. 
 
Uses of the Grid  

• Since the grid is always the same size (in world coordinates) in all views, this will help 
give you a sense of scale if one view is "zoomed-in" and another view is "zoomed-out". 

• If the Snap option is in GRID SNAP mode, then the grid intersections can be "snapped" 
to. You may find this useful when adding boundaries, support, etc. 

 
Tips 

• A shortcut for turning the grid on or off is to left-click on the word GRID on the status 
bar (ie. the first box to the left of the x,y coordinate display at the lower right of the 
screen). If the grid is on, the word GRID will be displayed, if the grid is off, this box will 
be empty. 

• The F7 function key can also be used to toggle the grid on and off. 
• The Grid Settings dialog can be accessed by right-clicking on the word GRID on the 

status bar. 
• The grid will eventually "disappear" if you keep zooming "out" on a model. This 

prevents the grid from becoming so dense that it hides the model. 
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Snap 
"Snapping" means that if the mouse cursor is moved close to a location that can be snapped, 
the cursor will jump to the exact location. (The x, y coordinate of the location will be shown 
on the status bar).  
 
There are three snapping modes available, which can be selected at any time: 
 

• NO SNAPPING -- disables the snapping feature 
• GRID SNAP -- snaps to the closest point on the grid. 
• VERTEX SNAP – snaps to the closest boundary vertex. NOTE that this also includes 

BOLT vertices. 
  
Tips 
There are numerous ways of changing the SNAP mode: 
 

• By selecting the Snap option in the View menu (this will bring up the Snap dialog) 
• By left-clicking on the SNAP option on the status bar (this will toggle through the three 

options) 
• By right-clicking on the SNAP option on the status bar (this will bring up the Snap 

dialog) 
• While adding boundaries, etc, a right-click will bring up a context menu with the SNAP 

options. 
• By typing v or g or n in the prompt line followed by Enter, to toggle vertex snap, grid 

snap, or no snap 
• The F9 function key will also toggle through the three snap modes. 
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Ruler 
The Ruler option in the View menu toggles the display of the ruler on or off.  
 
The ruler appears at the left and bottom edge of each view. 
 
 
Stress Block 

The Stress Block option in the View menu toggles the display of the "stress block" on or off, 
in the upper right corner of the view. The stress block indicates the relative magnitude and 
direction of the IN-PLANE principal field stresses. 
 
 
Ground Level 
The Ground Level option in the View menu toggles the display of a horizontal dotted line 
marking the Ground Surface Elevation, as entered in the Field Stress dialog. It is only 
applicable if you are using Gravity Field Stress .  
 
If you are using Constant Field Stress , the Ground Level option is not applicable. 
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Boundary Types 
The first step in creating a PHASE2 model (after setting your Limits and any necessary 
Project Settings) is to draw the boundaries defining the model. Boundaries are added using 
the Add options in the Boundaries menu or the toolbar (eg. Add Excavation , Add External 
, Add Material , Add Stage etc). Boundaries can also be added using the Import DXF option. 
 
The different boundary types defined in PHASE2 are: 
 
EXCAVATION 
Closed polylines representing excavations. In the case of staged excavations, an excavation 
boundary represents the final stage (or maximum extent) of an excavation, intermediate 
boundaries within the excavation, being represented by stage or material boundaries (see 
below). 
 
EXTERNAL 
Closed polyline, defining the extents of the finite element mesh, and encompassing all other 
boundaries. Only one external boundary can be defined for a model. 
 
MATERIAL 
Open (or closed) polylines, used to define boundaries between different material types. 
 
STAGE 
Open (or closed) polylines, used to define boundaries between different stages of an 
excavation. 
 
JOINT 
Open polyline, representing a joint or other discontinuity in the rock mass. Unlike material 
boundaries, a joint boundary is assigned properties (stiffness and strength). 
 
PIEZOMETRIC LINE 
A polyline representing a water table or Piezometric surface, used to calculate pore pressures 
for an effective stress analysis. 
 
NOTE: 

• An EXTERNAL boundary must always be defined for every model. 
• At least one EXCAVATION will usually be present in a model, except in certain cases 

such as 1)  surface excavation models may not always utilize an EXCAVATION 
boundary 2) a "joints only" model 3) an AXISYMMETRIC model will not normally 
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require EXCAVATION boundaries, since the EXTERNAL boundary implicitly defines 
the shape of the excavation. 

• MATERIAL, STAGE, JOINT and PIEZOMETRIC boundaries are optional, and are only 
defined if needed. 
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Entering Coordinates 
To enter model geometry, you may use the keyboard, the mouse, or a combination of the two, 
to enter coordinates. All boundaries are modeled by a series of straight-line segments defined 
by x-y coordinates. The coordinate system uses the convention: x is horizontal and increasing 
to the right and y is vertical and increasing upwards. 

 
Keyboard Entry 
Use the keyboard to type coordinates in the prompt line at the bottom right of the PHASE2 
application window. Simply type in x-y coordinate pairs, and press Enter for each pair. For 
example: 
 
   Enter vertex [a=arc, esc=quit]: 5 , 5 <Enter> 
   Enter vertex [a=arc, u=undo, esc=quit]: 5 , 10 <Enter> 
 
Note that the use of a comma to separate the x-y coordinates is optional, and you may simply 
leave a space between the x and y values in the prompt line. 
 
Graphical Entry 
Use the mouse to move the cursor, and enter a point by pressing the left mouse button. Note: 
• The cursor position is always displayed in the right-most box of the Status Bar.  
• The Length and Angle between the current cursor location, and the last vertex 
entered, is displayed at the bottom of the screen, as the cursor is moved. 
• The Grid and / or Snap options can help with graphical entry of boundaries. 
 
Tips 

• To complete the entry of an EXCAVATION boundary or a user-defined EXTERNAL 
boundary, right-click and select Close Boundary, or type c and Enter in the prompt line, 
after the last vertex has been entered. 

• To complete the entry of MATERIAL, STAGE, JOINT or PIEZOMETRIC boundaries, 
right-click and select Done, or press Enter with nothing in the prompt line, after the last 
vertex has been entered. 

• To abort the entry of any boundary press Escape or right-click and select Cancel. 
• While entering boundaries, various options are available in the right-click menu or 
by typing single-letter commands in the prompt line. See the following topics for details: 
Correcting Mistakes  
Drawing Arc Segments and Circles  
Toggling the Snap mode 
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Correcting Mistakes 
If at any time you make a mistake while entering boundaries, you may "undo" the vertices of 
the boundary you are entering, by: 
 

• Typing u followed by Enter in the prompt line, OR 
• Selecting Undo from the right-click menu. 

 
Either action will remove the last vertex from the current polyline you are entering. Undo 
can be repeated any number of times to remove successive vertices from a boundary you are 
drawing – experiment with this option to see how it works. 
 
Tips 

• If you have made a mistake entering an arc , the Undo command will remove the entire 
arc (ie. all vertices on the arc segment). 

• Each time you undo a vertex, a small cross remains at the location. These are 
temporary, so that the user can see the location of the removed vertex. They will 
disappear as soon as the boundary has been completed. 

• The u command is only operative while you are entering a boundary. After a boundary 
has been added, you can use the Undo or Edit options in the Edit menu, to remove or 
edit boundaries. 

 



 

 44 

Drawing Arc Segments and Circles 
While you are entering a boundary in PHASE2, you can easily create an arc segment or a 
circle. The following instructions assume that you have already selected one of the Add 
Boundary options (eg. Add Excavation, Add External, Add Material etc), and are in the 
mode for entering vertices of a boundary. 
 
Arc Segment 
To create an arc segment: 

1. Enter the first point of the arc, graphically with the mouse, or through the keyboard. 
2. Select Arc from the right-click menu, or type a followed by Enter in the prompt line. 
3. In the prompt line, enter a number of segments for the arc, or press Enter to accept the 

default value of 20.  
4. You will be prompted to enter the second arc point. Enter any intermediate point on the 

arc (for example, the midpoint between the beginning and end points of the arc). 
5. As you move the mouse, you will see an arc drawn on the screen, connecting the first 

and second points with the current cursor location. 
6. You will be prompted to enter the third arc point. After entering the third point, the arc 

will be drawn connecting the three points you have entered. 
7. Continue entering vertices as usual, to complete the boundary. 

 
Note: 

• The arc is actually made up of straight-line segments. The number of segments will 
equal the number you have entered in Step 3 above. 

• If you press c and Enter before selecting the third point, the arc will close on the start 
point of the current polygon. 

 
Circle 
To create a circle: 

1. Enter any point on the circle, graphically with the mouse, or through the keyboard. 
2. Select Arc from the right-click menu, or type a followed by Enter in the prompt line.  
3. In the prompt line, enter the number of segments for the circular boundary. 
4. Enter a point on the circle diametrically opposite the first point entered in Step 1. 
5. Type c and Enter (or right-click and select Close Boundary), and you will have drawn a 

circle with a diameter between the two points. 
 
The Arc option is intended mainly for use with EXCAVATION boundaries, but may be used 
with any boundary type . 
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Automatic Boundary Intersection 
When adding or editing boundaries, PHASE2 has built-in logic which automatically 
intersects boundaries with each other. The routine is very general – whenever boundaries 
are drawn (or edited) such that they intersect existing boundaries: 

• new vertices will be inserted at all intersection points 
• all invalid boundary segments will be automatically removed (for example, segments 

outside of the external boundary) 
 
EXAMPLE1 

1. Create a simple EXCAVATION and EXTERNAL boundary model. 
2. Add a single segment MATERIAL boundary with both endpoints outside of the 

EXTERNAL boundary, and which crosses the EXCAVATION. 
3. After the boundary is added, you should notice the following: 

• Vertices are automatically created at all intersection points of the MATERIAL 
boundary with the EXCAVATION and EXTERNAL boundaries. 

• the portions of the MATERIAL boundary outside of the EXTERNAL boundary are 
automatically removed. 

 
EXAMPLE2 

1. Using the same model created above, move the EXCAVATION a short distance from its 
original location, such that it still intersects the MATERIAL boundary. 

2. Notice that new vertices are again created where the MATERIAL and EXCAVATION 
boundaries intersect. 

 
Tips 

• This automatic intersection capability is intended as a convenience, and may prove 
useful in many situations. The user is encouraged to EXPERIMENT with this 
capability of PHASE2. However, there may also be times when it is more appropriate, 
or simpler, to manually add new vertices to boundaries, rather than having them 
automatically generated. 

• If you are in Vertex Snap mode while entering boundaries, if you hover the mouse over 
a boundary, and click the left mouse button, the new vertex will automatically be 
inserted at the nearest point on the boundary. See the Snap topic for details.  
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Add Excavation 
To add an EXCAVATION boundary to your model: 
 

1. Select Add Excavation from the toolbar or the Boundaries menu. 
2. Enter the vertices of the excavation as described in Entering Coordinates. 
3. An excavation boundary must always be closed. To close the excavation boundary, after 

all vertices are entered, right-click and select Close Boundary, or you can type c and 
Enter in the prompt line. This automatically and correctly closes the excavation, and 
saves the user the trouble of having to re-enter the first vertex to complete the 
boundary. 

 
Tips 

• While you are entering a boundary, you can undo mistakes, draw arc segments or 
circles, and activate the vertex snap or grid snap options. See the following topics for 
information: 

Correcting Mistakes  
Drawing Arc Segments and Circles  
Toggling the Snap mode 
• If the vertex snap option is activated, you can also close an excavation boundary by 
snapping to the first vertex after all other vertices are entered. 
 
Excavation Boundaries and Staging 
In a multi-stage model, an EXCAVATION boundary represents the maximum extent of an 
excavated region. Intermediate boundaries within excavations, representing different stages 
of excavation, must be represented by STAGE boundaries or MATERIAL boundaries. 
 
Surface Excavations 
If you are using EXCAVATION boundaries to model a surface excavation, you will have to 
make sure that the EXCAVATION and EXTERNAL boundaries are coincident with each 
other, where appropriate. 
 
For a tutorial on modeling surface excavations, see the PHASE2 User’s Guide. 
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Add External 
The EXTERNAL boundary, as defined in PHASE2, encompasses all other model boundaries, 
and defines the extents of the finite element mesh. Note: 
 

• An EXTERNAL boundary must be defined for every model; otherwise the finite element 
mesh cannot be generated. 

• Only one EXTERNAL boundary can be defined for a given model. 
 
To add the EXTERNAL boundary to your model: 
 

1. Select Add External from the toolbar or the Boundaries menu. 
2. You will see the Create External Boundary dialog, shown below. This dialog allows you 

to choose from 3 different automatically generated EXTERNAL boundary types, or a 
user-defined, manually entered external boundary. 

 

  
 
Automatically Generated External Boundary 
The three automatically generated external boundary types are Box, Circle and Hull. If you 
select one of these options as the Boundary Type, the external boundary will be generated as 
soon as you select OK in the Create External Boundary dialog. The Box, Circle and Hull 
options are illustrated below, for an Expansion Factor of 1. 
 

      
 
 BOX CIRCLE HULL 
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Box 
The Box external boundary will in general be a rectangle. It will be a square if the horizontal 
and vertical extents of your excavation(s) are equal. 
 
Circle 
The Circle external boundary option actually generates a regular 10-sided polygon 
approximating a "circle" around the excavation(s). 
 
Hull 
The Hull option produces an external boundary which is a magnified version of the 
excavation(s). It will work for multiple excavations, although it is more appropriate for a 
single, non-convex excavation. 
 
Expansion Factor 
The Expansion Factor in the Create External Boundary dialog determines how far the 
automatically generated external boundary will be projected relative to your excavation 
dimensions. The default Expansion Factor is 3, but can be changed to any number between 
0.2 and 1000. If more than one excavation is present, the Expansion Factor takes into 
account the combined extent of all excavations. 
 

     
 EXP.FACT=3 EXP.FACT=2 EXP.FACT=1  
 
 Effect of Expansion Factor (Boundary Type = BOX) 
 
User-Defined External Boundary 
To enter an arbitrary, user-defined EXTERNAL boundary: 
 

1. Select User Defined as the Boundary Type in the Create External Boundary dialog.  
2. Select OK in the dialog, and you can begin entering a user-defined external boundary. A 

user-defined external boundary is entered in exactly the same way as an EXCAVATION 
boundary – see the Add Excavation topic for details.  

 



 

 49

The EXTERNAL boundary must always be closed – as with excavations, you can close the 
boundary after entering all vertices, by selecting Close Boundary from the right-click menu, 
or typing c and Enter in the prompt line. You must enter a user-defined EXTERNAL 
boundary if: 
 

• Your model does not include EXCAVATION boundaries (eg. a single stage surface 
excavation, a "joints only" analysis, or an AXISYMMETRIC problem), OR 

• You want to enter the external boundary before the excavations. 
 
This is because the automatic generation options for the EXTERNAL boundary (Box, Circle 
and Hull, see above) are only applicable if EXCAVATION boundaries exist.  
 
NOTE:  

• If EXCAVATION boundaries have not been defined, and you select the Add External 
option, you will NOT see the Create External Boundary dialog. Instead you will be able 
to immediately begin entering the vertices of the user-defined EXTERNAL boundary. 
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Add Material 
A MATERIAL boundary is used in PHASE2 to define regions with different material 
properties. If your entire model consists of a single rock type with uniform material 
properties throughout, then MATERIAL boundaries are not necessary. If you wish to define 
regions having different material properties (eg. strength and elastic properties), then use 
MATERIAL boundaries to define the regions. 
 
To add a MATERIAL boundary to your model: 
 

1. Select Add Material from the toolbar or the Boundaries menu. 
2. Enter the vertices of the material boundary as described in Entering Coordinates. 
3. When all vertices are entered, right-click and select Done, or press Enter with nothing 

in the prompt line, and the MATERIAL boundary will be added to the model. 
 

   
 
Examples of MATERIAL boundaries: On the left, two MATERIAL boundaries define three 
regions. On the right, a single material boundary defines two regions. 
 
Typically, a MATERIAL boundary will be a single line segment dividing the model into sub-
regions by virtue of intersection with other boundaries, as illustrated above. However, the 
definition of a MATERIAL boundary in PHASE2 is completely general – it can have any 
number of segments, can intersect any other boundaries (including other MATERIAL 
boundaries), and can even be a closed boundary. 
 
NOTE: 

• The EXTERNAL boundary must exist before MATERIAL boundaries can be added to a 
model.  

• MATERIAL boundaries should, in general, define closed regions by virtue of 
intersection with other boundaries (EXCAVATION, EXTERNAL, JOINT, STAGE or 
other MATERIAL boundaries). If a MATERIAL boundary is terminated without 
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intersecting another boundary, then it will not serve the purpose of defining a separate 
material region (you will discover this when you try to Assign properties). In the 
interest of generality PHASE2 allows "open-ended" MATERIAL boundaries to be 
defined. One possible use of such boundaries is for conforming the finite element mesh 
along any desired line. 

 
Material Boundaries vs. Stage Boundaries 
As of PHASE2 version 5.0, MATERIAL boundaries and STAGE boundaries can be used 
interchangeably. That is, anywhere a MATERIAL boundary can be used, a STAGE boundary 
can also be used, and vice versa. The user may decide which boundary type is more 
appropriate in a given situation (ie. use MATERIAL boundaries to represent boundaries 
between different materials, and use STAGE boundaries to represent the boundaries 
between different stages of excavation). 

• Note: in previous versions of PHASE2, MATERIAL and STAGE boundaries were not 
exactly equivalent, since STAGE boundaries could only be defined within 
EXCAVATION boundaries. This restriction has now been removed. See the Add Stage 
topic for more information. 
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Add Stage 
PHASE2 allows staged analysis of excavations in up to 50 separate stages. The Number of 
Stages is set in the Project Settings dialog. 
 

• If you are working with staged models, then you can use STAGE boundaries to define 
intermediate excavation stages within EXCAVATION boundaries. 

• IMPORTANT NOTE: as of PHASE2 version 5.0, STAGE boundaries may now be 
defined outside of EXCAVATION boundaries, and are no longer restricted to be within 
EXCAVATION boundaries. See note below. 

 
To add a STAGE boundary to a model: 
 

1. Select Add Stage from the toolbar or the Boundaries menu. 
2. Enter the vertices of the stage boundary as described in Entering Coordinates. 
3. When all vertices are entered, right-click and select Done, or press Enter with nothing 

in the prompt line, and the STAGE boundary will be added to the model. 
 

     
 STAGE 1 STAGE 2 STAGE 3   
 
Example of a three stage model, using two STAGE boundaries within the main 
EXCAVATION boundary. 
 
NOTE: 

• As of PHASE2 version 5.0, STAGE boundaries may now be defined outside of 
EXCAVATION boundaries, and are no longer restricted to be within EXCAVATION 
boundaries. This is because (as of PHASE2 version 5.0), the user may now excavate any 
closed region of the model, regardless of what boundary types are used to define the 
region. Previously, only regions within EXCAVATION boundaries could be excavated. 
This allows the user maximum flexibility in defining model boundaries, using STAGE 
and / or MATERIAL and / or EXCAVATION boundaries. 
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Stage Boundaries vs. Material Boundaries 
Because STAGE boundaries may now be defined anywhere within the EXTERNAL 
boundary, MATERIAL boundaries and STAGE boundaries can be used interchangeably in 
PHASE2. That is, anywhere a MATERIAL boundary can be used, a STAGE boundary can 
also be used, and vice versa. The user may decide which boundary type is more appropriate 
in a given situation (ie. use MATERIAL boundaries to represent boundaries between 
different materials, and use STAGE boundaries to represent the boundaries between 
different stages of excavation). 
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Add Joint 
The Add Joint option allows the user to define either: 
 

• natural joints existing in the rockmass prior to excavation, or  
• artificial (man-made) joints, which only exist after a region has been excavated, and 

then backfilled with another material. 
 
To add a JOINT to your model: 
 

1. Select Add Joint from the toolbar or the Boundaries menu. 
2. You will see the Create Joint dialog. This allows you to specify the joint as either 

Natural or Artificial. Make your selection in this dialog, and select OK. (See below for 
details about Natural and Artificial Joints, and also the Pin Ends of Joint Together 
option in the Create Joint dialog). 

3. Enter the vertices of the joint boundary as described in Entering Coordinates. 
4. When all vertices are entered, right-click and select Done, or press Enter with nothing 

in the prompt line. 
 
In terms of its behavior as a boundary in a PHASE2 model, a JOINT is identical in most 
respects to a MATERIAL boundary – see the Add Material section for details. The main 
difference between a JOINT and a MATERIAL boundary is that a JOINT is assigned 
strength and stiffness properties, whereas a MATERIAL boundary cannot be assigned 
properties. 
 
Although typically a JOINT will consist of a single line segment, PHASE2 allows a very 
general definition of a JOINT boundary. It can consist of any number of segments, and can 
intersect any other type of boundary, including other JOINTS.  
 
There is one restriction on the use of JOINT boundaries in PHASE2 – JOINTS cannot be 
used in conjunction with AXISYMMETRIC modeling, as the joint elements used in PHASE2 
are only compatible with a PLANE STRAIN model. If you are using the Axisymmetric 
modeling option, the Add Joint option will be disabled. A discussion of joint elements can be 
found in the book "Numerical Methods in Rock Mechanics" by G.N. Pande, G. Beer & J.R. 
Williams, John Wiley and Sons Ltd., 1990. 
 
Natural Joints 
A Natural joint, as defined in PHASE2, is a joint which exists in the rockmass prior to 
excavation. It will remain present in the model, at all stages, unless the material on one (or 
both) sides of the joint, has been excavated. Note that if the material has been excavated on 
one (or both) sides of a Natural joint, that portion of the joint will no longer exist in the 
model, even if the excavated region is later backfilled at a subsequent stage. After 
excavating, the joint boundary will still be displayed on the model, however, it will be 
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displayed in a lighter colour, indicating that it is no longer in effect (for all stages after 
excavation). 
 
Artificial Joints 
An Artificial joint, as defined in PHASE2, is a man-made joint, which only exists AFTER the 
region on one (or both) sides of the joint, has been excavated in one stage, and then backfilled 
with another material, in a subsequent stage. When you initially add an Artificial joint (and 
then mesh the model), you will notice that the joint is displayed in a lighter colour. This 
indicates that the joint does not yet actually exist in the model. The joint will be displayed in 
its normal colour, indicating that it is in effect, only after you have done the following (using 
the Assign Properties dialog): 

• excavated the material on one (or both) sides of the joint, in one stage 
• backfilled against the joint, with another material, in a subsequent stage 

This is the method of defining an artificial joint in PHASE2, and is intended to model any 
type of artificial joint which is designed or expected to slide, during the staged construction of 
an excavation. 
 
Pin Ends of Joint Together 
In the Create Joint dialog, you will see the Pin Ends of Joint Together option. The 
significance of this option is as follows: 
 
After the finite element mesh has been generated, each segment of a joint boundary 
corresponds to the edges of two finite elements, and represents a "joint element". Unlike 
other boundaries in PHASE2, each node along a joint boundary, is in fact two different and 
independent nodes. You may observe this as follows: 

• Add a joint boundary to a model, and generate the mesh. In the Display Options dialog, 
turn on the Node Numbers option and the Shrink Elements option. Now zoom in closely, 
to any node along the joint boundary. You will see that the node numbering, on either 
side of the joint, is different.  

This dual node numbering of joint boundaries, is required in order to allow opposite sides of 
the joint to move with respect to each other, if yielding (slip) occurs in the joint. 
 
At the ends of a joint boundary, this dual node scheme can lead to unexpected results, 
particularly if a joint boundary is terminated within the finite element mesh. This is 
because, at the end of a joint boundary, the joint boundary will still have two nodes, but in 
order for displacement continuity to be maintained within the finite element mesh, a single 
node is required at this location. This situation can lead to unexpected "gaps", or 
"overlapping" of material, at the ends of a joint, which is not kinematically feasible. 
 
In order to address this situation, the Pin Ends of Joint Together option, allows the user to 
ensure that if a joint boundary is terminated within the finite element mesh, ONLY ONE 
NODE will exist at this location. However, it is also important to realize that, if the ends of a 
joint are pinned together, stress concentrations may result at these locations, since relative 
movement can no longer occur at the joint ends, but may occur elsewhere along the joint. 
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The user may decide when it is appropriate to use the Pin Ends of Joint Together option. A 
detailed examination of the displacements and stresses at the ends of a joint, may be 
necessary in order to determine how the end of the joint is behaving. 
 
NOTE: 

• When the Pin Ends of Joint Together option is in effect, this will be indicated on the 
model, by small circles drawn around the first and last vertices of the joint boundary. 
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Add Piezometric Line 
Piezometric Lines are used for calculating pore pressure when the Groundwater Method in 
Project Settings is set to Piezometric Lines. A Piezometric Line in PHASE2 can represent a 
water table, or an actual Piezometric surface obtained from piezometer measurements, for 
example. 
 
To add a Piezometric Line to your model: 
 

1. Select Add Piezometric Line from the toolbar or the Boundaries menu. 
2. Enter the vertices of the Piezometric Line as described in Entering Coordinates. 
3. When all vertices are entered, right-click and select Done, or press Enter with nothing 

in the prompt line. 
4. The Piezometric Line will appear on the model as a blue line, with an automatically 

assigned ID number (see below for details). 
 
Piezometric Line ID Number 
Piezometric Lines are automatically given an ID number, which will appear at the mid-point 
of the first and last segments of the Piezometric Line. This ID number is used to identify 
Piezometric Lines with the corresponding material region(s) of the model, in the Define 
Groundwater Properties dialog. The Piezometric Line ID numbers range from 1 to 20, and 
are assigned in order, according to how many Piezometric Lines are already defined. A 
maximum of 20 Piezometric Lines can be defined for a model. 
 
Piezometric Lines and Staging 
For staged models, different Piezometric Lines can be applied at different stages of the 
model, in order to model changing groundwater conditions at different stages. This is done 
through the Define Groundwater Properties dialog, see that topic for details.  
 
Pore Pressure Calculation 
Pore pressure calculation for a Piezo Line is described in the Pore Pressure Calculation for a 
Piezometric Line topic. 
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Water Pressure Grid 
Groundwater conditions are most accurately modeled by a grid of water pressure data, from 
which the pore pressure at any point in the ground can be determined. The grid could be 
based on field measurements, or could be the output from a groundwater analysis program, 
for example. 
 
The Water Pressure Grid option is only enabled if the Groundwater Method in Project 
Settings is set to one of the three Water Pressure Grid options available in PHASE2: 
 

• Grid (Total Head)  

• Grid (Pressure Head) 

• Grid (Pore Pressure) 

 
To define a Water Pressure Grid: 
 

1. Set the desired Water Pressure Grid type in the Project Settings dialog. 
2. Select Water Pressure Grid from the Boundaries menu. 
3. Grids can be imported (see below for details), or entered manually as described in steps 

4 to 5. 
4. Each point is defined by x and y coordinates, and a value, corresponding to the Water 

Pressure Grid type (Total Head, Pressure Head, or Pore Pressure) selected in Project 
Settings.  

5. Enter the data in the grid. When finished select OK, and the location of each grid point 
will be marked by a blue triangle on the model. 

 

NOTE: The Water Pressure Grid values can be displayed at each grid point with the Display 
Options dialog. By default, they are NOT displayed. 

 
Importing Water Pressure Grid Files 
The Import button in the Water Pressure Grid dialog allows the user to import an existing 
Water Pressure Grid file, into the current PHASE2 model. Two file formats can be imported: 
 

• .PWP files – PHASE2 uses a .PWP (pore water pressure) file name extension to 
identify Water Pressure Grid data files. A .PWP file is a simple text file, where each row 
of the file has the format (x, y, value). The type of the value must correspond to the 
Groundwater Method in Project Settings (Total Head, Pressure Head or Pore 
Pressure) 

• .DXF files – Water Pressure Grids can also be imported into PHASE2 from a .DXF file 
(this is useful if for example, a flow net has been digitized from a drawing using 
AutoCAD).  
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Exporting Water Pressure Grid Files 
The Export button in the Water Pressure Grid dialog allows the user to export the current 
data in the Water Pressure Grid dialog, to a .PWP file (see above for the definition of a .PWP 
file). This is useful if you wish to later import the same Water Pressure Grid into another 
PHASE2 model. 
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DXF Import/Export 
Boundaries can be imported into a PHASE2 model from a DXF file using the Import DXF 
option in the File menu. See the Import DXF topic for details. 
 
Boundaries can also be exported to a DXF file using the Export DXF option. 
 
 

Delete Boundaries 
To delete boundaries: 
 

1. Select Delete Boundaries from the toolbar or the Edit sub-menu of the Boundaries 
menu. 

2. Use the mouse to select the boundaries you would like to delete. 
3. When you are finished selecting, press Enter or right-click and select Done Selection, 

and the boundaries you selected will be deleted. 
 
Move Boundaries  
Add Vertices  
Delete Vertices  
Move Vertices  
Scale Excavation  
Rotate Excavation  
Copy Excavation  
Selection Filter  
 



 

 61

Move Boundaries 
To move boundaries: 
 

1. Select Move Boundaries from the toolbar or the Edit sub-menu of the Boundaries 
menu. 

2. Use the mouse to select the boundaries you would like to move. 
3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will then be prompted to enter two points defining the move. You can enter the 

points graphically with the mouse, or with the keyboard in the prompt line. 
5. After the second point is entered, all of the boundaries selected in Step 2 will be 

translated from their original positions according to the vector defined by the two 
points. 

 
Tips 

• The two points defining the move can be anywhere in the x-y plane, only their relative 
positions are important. 

• If you enter 0 , 0 as the first point defining the move, then you can enter the actual x 
and y displacement as the second point. For example, if you want to move a boundary 5 
meters to the left, enter 0 , 0 as the base point, and –5 , 0 as the second point. 

 
Delete Boundaries  
Add Vertices  
Delete Vertices  
Move Vertices  
Scale Excavation  
Rotate Excavation  
Copy Excavation  
Selection Filter  
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Add Vertices 
New vertices can be added to existing boundaries using the Add Vertices option: 
 

1. Select Add Vertices from the toolbar or the Edit sub-menu of the Boundaries menu. 
2. As you move the mouse, a red cross snaps to the nearest point on the nearest boundary, 

following the cursor. You can use this as a guide to graphically add a new vertex, by 
clicking the left mouse button when the green cross is at the desired location. NOTE: 
the coordinates displayed in the Status Bar at the lower right of the screen, are the 
coordinates of the green cross on a boundary, and NOT the cursor coordinates. 

3. You can also enter the coordinates of a new vertex in the prompt line, however, note the 
following – the coordinates you enter in the prompt line must be either exactly ON a 
boundary, or very close to a boundary, in order for a vertex to be added. If the point 
entered is too far from a boundary, you will see a warning dialog, and be prompted to 
enter new coordinates. If the point is only slightly off, a vertex will be added at the 
nearest point on the boundary. 

4. You can add any number of new vertices by repeating Steps 2 or 3. When you are 
finished, press Escape or right-click and select Done. 

 
Delete Boundaries  
Move Boundaries  
Delete Vertices  
Move Vertices  
Scale Excavation  
Rotate Excavation  
Copy Excavation  
Selection Filter  
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Move Vertices 
To move vertices to a new location: 
 

1. Select Move Vertices from the toolbar or the Edit sub-menu of the Boundaries 
menu. 

2. You can select individual vertices by clicking on them with the left mouse button or 
multiple vertices by drawing a window around them (click and hold the left mouse 
button, and drag to create a window). 

3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will then be prompted to enter two points defining the move. You can enter the 

points graphically with the mouse, or with the keyboard in the prompt line. 
5. After the second point is entered, all of the vertices selected in Step 2 will be translated 

from their original positions according to the vector defined by the two points. 
 
Tips 

• The two points defining the move can be anywhere in the x-y plane, only their relative 
positions are important. 

• If you enter 0 , 0 as the first point defining the move, then you can enter the actual x 
and y displacement as the second point. For example, if you want to move a vertex 5 
meters to the left, enter 0 , 0 as the base point, and –5 , 0 as the second point. 

• You may also find it useful to use the snap options (vertex or grid snap), to snap exactly 
to existing vertices, or grid points, when selecting the base point and / or the second 
point, defining the move. 

 
Delete Boundaries  
Move Boundaries  
Add Vertices  
Delete Vertices  
Scale Excavation  
Rotate Excavation  
Copy Excavation  
Selection Filter  
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Delete Vertices 
To delete boundary vertices: 
 

1. Select Delete Vertices from the toolbar or the Edit sub-menu of the Boundaries 
menu. 

2. You can select individual vertices by clicking on them with the left mouse button, or you 
can select multiple vertices by drawing a window around them (click and hold the left 
mouse button, and drag to create a window). 

3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. All selected vertices will be deleted and all boundaries will be redrawn using the 

remaining vertices. 
 
Delete Boundaries  
Move Boundaries  
Add Vertices  
Move Vertices  
Scale Excavation  
Rotate Excavation  
Copy Excavation  
Selection Filter  
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Scale Excavation 
The Scale option can be used to scale the size of an EXCAVATION. To use Scale: 
 

1. Select Scale from the Edit sub-menu of the Boundaries menu. 
2. Use the mouse to select the excavation(s) you would like to scale. 
3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will then be prompted to enter a base point for the scaling. Use the mouse or enter 

the x-y coordinates of the base point in the prompt line. 
5. You will then be prompted to enter the scaling in the x and y directions. Enter scale 

factors for both the x and y directions and press Enter, and all selected excavation(s) 
will be scaled about the base point. (Example: [ 1.5 , 1 ] would increase the x-axis 
dimensions by 50% and leave the y-axis dimensions the same). 

 
Tips 

• To scale an excavation about its center, enter the centroid of the excavation as the base 
point. 

• To scale an excavation about any vertex, enter the vertex as the base point (this will 
leave the position of the vertex at the base point unchanged, and scale the location of all 
other vertices according to the (x,y) scale factors and the distance from the base point). 

• An ellipse can be created from a circle by using the Scale option. 
 
Delete Boundaries  
Move Boundaries  
Add Vertices  
Delete Vertices  
Move Vertices  
Rotate Excavation  
Copy Excavation  
Selection Filter  
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Rotate Excavation 
The Rotate option can be used to rotate an EXCAVATION. To use Rotate: 
 

1. Select Rotate from the Edit sub-menu of the Boundaries menu. 
2. Use the mouse to select the excavation(s) you would like to rotate. 
3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will then be prompted to enter a base point for the rotation. Use the mouse or enter 

the x-y coordinates of the base point in the prompt line. 
5. You will then be prompted to enter a rotation in degrees. The positive convention is 

counter-clockwise. Enter the rotation in the prompt line and press Enter, and all 
selected excavation(s) will be rotated about the base point. 

 
Tips 

• To rotate an excavation about its center, enter the centroid of the excavation as the base 
point. 

• To rotate an excavation about any vertex, enter the vertex as the base point (this will 
leave the position of the vertex at the base point unchanged, and rotate all other 
vertices about the base point). 

 
Delete Boundaries  
Move Boundaries  
Add Vertices  
Delete Vertices  
Move Vertices  
Scale Excavation  
Copy Excavation  
Selection Filter  
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Copy Excavation 
The Copy option can be used to make copies of EXCAVATIONS. To use Copy: 
 

1. Select Copy from the Edit sub-menu of the Boundaries menu. 
2. Use the mouse to select the excavation(s) you would like to copy.  
3. When you are finished selecting, press Enter or right-click and select Done Selection. 

4. You will then be prompted to enter a base point. Use the mouse or enter the x-y 
coordinates of the base point in the prompt line. 

5. After the base point is entered, if you move the mouse, you will see an outline of your 
selected excavation(s) following the mouse. Enter a second point with the mouse or the 
keyboard, and the excavation(s) will be copied to the new location. 

 
Tips 
• To define a relative distance for the copy, enter 0 , 0 as the base point in the prompt 
line, and the relative distance as the second point. That is, if you wanted a copy of an 
excavation 20 meters above and 30 meters to the right of the original excavation, enter 0 , 0 
as the base point, and 20 , 30 as the second point.  

• If you do not know the relative distance, then enter a vertex of the original excavation 
as the base point, and the new coordinates of the equivalent vertex on the copied 
excavation, as the second point.  

 
Delete Boundaries  
Move Boundaries  
Add Vertices  
Delete Vertices  
Move Vertices  
Scale Excavation  
Rotate Excavation  
Selection Filter  
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Selection Filter 
The Selection Filter allows the user to choose which boundary types can be selected for 
editing.  
 
The Selection Filter is available in: 

• the Edit sub-menu of the Boundaries menu 
• the right-click menu for all applicable options (eg. Delete Boundary, Move Boundary 

etc) 
 
By default, all boundaries are initially selectable in the Selection Filter dialog. The main 
purpose of the Selection Filter is to allow the user to select boundaries with a window, but 
filter out the selecting of some boundary types which may be within the window. 
 

  
 
Example 
Let’s say a model had numerous STAGE boundaries that the user wanted to delete, without 
deleting any EXCAVATIONS. They could turn "off" all boundary types in the Selection 
Filter except for STAGE boundaries, and then select all excavations with a window while 
using the Delete Boundaries option, and only the STAGE boundaries would be selected and 
deleted. 
 
NOTE:  

• The Selection Filter is automatically reset after each use, so that all boundaries are 
selectable, once the current operation has been completed. 

• The Selection Filter can be used at any time during the selection process. For 
example, if you accidentally select boundaries that you did not intend to select, you can 
use the Selection Filter to un-select any given boundary type, even after boundaries 
have been selected. 

• In addition to the boundary editing options, the Selection Filter is also applicable to 
other PHASE2 options. For example, while Custom Discretizing , Adding / Deleting 
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Tractions , Adding / Deleting Liners , etc, the Selection Filter is available in the right-
click menu. 

 
See the Selecting topic for more tips and information on selecting entities in PHASE2. 
 
 
Delete Piezometric Line 
The purpose of the Delete Piezometric Line option, is to allow the user to delete a 
Piezometric Line, if necessary, after the finite element mesh has been generated. This is 
because all regular boundary editing options in PHASE2 are disabled after the mesh is 
generated, since the mesh must be reset in order to add, edit or delete boundaries other than 
Piezometric Lines. 
 
Unlike other boundary types in PHASE2, Piezometric Lines may be added or deleted, after 
the mesh has been generated, since a Piezometric Line boundary is independent of the finite 
element mesh, and is not involved in generating the mesh.  
 
Note: 

• The Delete Piezometric Line option works in the same manner as the Delete 
Boundary option. See the Delete Boundary topic for details.  

• The Delete Boundary option can be used to delete a Piezometric Line, like any other 
boundary, before the mesh has been generated.  

• If you wish to add, delete or move vertices of Piezometric Lines, then the mesh must be 
reset, since these editing options are disabled when a mesh exists. 

• The Delete Piezometric Line option is available in the toolbar or the Edit sub-menu 
of the Boundaries menu. 
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Mesh Overview 
After defining all boundaries, the next step is to create the finite element mesh. PHASE2 
incorporates a state-of-the-art 2 dimensional automatic finite element mesh generator, which 
can generate meshes based on either triangular or quadrilateral finite elements. 
 
To give the user maximum flexibility in defining the mesh, the mesh generation procedure is 
performed in two steps: 
 
1.   FIRST DISCRETIZE!!! 
You must first discretize the boundaries by selecting the Discretize option. This process 
subdivides the boundary line segments into discretizations which will form the framework of 
the finite element mesh.  
 
2.   THEN MESH!!! 
After discretizing, select the Mesh option, to generate the finite element mesh, which will be 
based on the discretization, and the mesh and element types in the Mesh Setup option. 
 
NOTE: 

• The main parameters controlling the discretization and meshing, are found in the Mesh 
Setup dialog. 

• Before the mesh has been generated, the discretization can be customized by the user 
with either the Advanced Discretization option in the Mesh Setup dialog, and / or the 
Custom Discretize option in the toolbar or the Mesh menu. 

• After the mesh has been generated, various options are available for refining or 
customizing the mesh, in the Mesh Refinement sub-menu of the Mesh menu. 
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Mesh Setup 
The Mesh Setup option, available in the Mesh menu or the toolbar, controls the main 
parameters which define the discretization and meshing of the model. This includes: 
 
Mesh Type  
Element Type  
Gradation Factor  
Number of Excavation Nodes  
Advanced Discretization  
 
NOTE: 

• The Discretize and Mesh buttons in the Mesh Setup dialog, allow the user to see the 
results of applying the current Mesh Setup parameters, without closing the dialog.  

• It is important to note that these buttons are exactly equivalent to the use of the 
Discretize and Mesh options in the mesh menu or the toolbar.  

• The current parameters in the Mesh Setup dialog, will be applied whenever Discretize 
or Mesh are selected from the toolbar, the menu, or the Mesh Setup dialog.  

• Customizing of the discretization and mesh, beyond what is determined by the Mesh 
Setup dialog, can be done with the Custom Discretize option, and the options in the 
Mesh Refinement sub-menu in the mesh menu. 
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Mesh Type 
The user can choose from 3 different Mesh Types in the Mesh Setup dialog: 
 
Graded  
Uniform  
Radial  
 
A Graded mesh will be used in almost all models, but Uniform or Radial meshing may 
occasionally be useful in special cases. 
 
Note that each different Mesh Type requires different associated setup parameters, as 
described in the Graded, Uniform and Radial Mesh Type topics. 
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Graded Mesh 
In the Mesh Setup dialog, the default Mesh Type is Graded, which produces a good graded 
mesh for most models, using what is known as a quadtree nodal insertion technique. In the 
majority of cases you will use a Graded mesh type.  
 
When the Mesh Type = Graded, you will be required to specify the Element Type , Gradation 
Factor and Number of Excavation Nodes in the Mesh Setup dialog.  
 
In the example below: 
 
Mesh Type = Graded 
Number of Excavation Nodes = 60 
Gradation Factor = 0.1 
Element Type = Triangles 
 

 
 
Number of Excavation Nodes 
The Number of Excavation Nodes directly determines the discretization of the EXCAVATION 
boundaries. If more than one EXCAVATION is defined, remember that this number is the 
total for all excavations. 
 
PHASE2 subdivides the EXCAVATION boundaries in such a way that the number of 
excavation nodes is approximately equal to the Number of Excavation Nodes in Mesh Setup. 
You may notice that the actual number of excavation nodes after discretizing may differ 
slightly from the Number of Excavation Nodes in the Mesh Setup option. This is normal, 
and will vary depending on the excavation(s).  
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The Number of Excavation Nodes in conjunction with the Gradation Factor, determines the 
discretization of all other boundaries in the model, as described below. 
 
Gradation Factor 
The Gradation Factor, in conjunction with the Number of Excavation Nodes, determines the 
discretization of all other boundaries in the model (ie. EXTERNAL, MATERIAL, STAGE and 
JOINT). 
 
The Gradation Factor is the ratio of: 

• the average length of discretizations on EXCAVATION boundaries, to 
• the length of discretizations on the EXTERNAL boundary, at the maximum distance 

from the EXCAVATION boundaries 
 
The discretization of all other boundaries in the model is graded, according to the distance of 
the boundary from EXCAVATION boundaries. 
 
For a simple model where the EXTERNAL boundary is equally distant from the 
EXCAVATION boundary, a Gradation Factor of 0.1 implies that the average length of the 
EXTERNAL boundary discretizations will be (approximately) 10 times the average length of 
the EXCAVATION discretizations. This is illustrated below.  
 
Due to the nature of the discretization process, the Gradation Factor should be considered an 
approximate number. 
 

     
 G.F.=0.1 G.F.=0.2 G.F.=0.3 
 
Effect of Gradation Factor on the mesh. From left to right, Gradation Factor = 0.1, 0.2, 
0.3. (The Expansion Factor of the External Boundary is equal to 1 in this case). 
 
As a rule of thumb, the farther away the EXTERNAL boundary is from the excavations (ie. 
the greater the Expansion Factor), the smaller the Gradation Factor should be, so that you 
do not end up with an unnecessarily large number of elements. 
 
Number of External Boundary Nodes 
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Not all PHASE2 models will necessarily use EXCAVATION boundaries. In the case of a 
model with no EXCAVATION boundaries, for example: 
 

• surface excavation models 
• an AXISYMMETRIC model 
• a "joints only" model 
• any other model that does not require an EXCAVATION boundary 

 
the Mesh Setup dialog will allow you to enter the Number of External Boundary Nodes, 
rather than the Number of Excavation Nodes. In this case, the Gradation Factor is not 
applicable and will be disabled, since the Gradation Factor is only relevant if EXCAVATION 
boundaries exist.  
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Uniform Mesh 
In the Mesh Setup dialog, if the Mesh Type = Uniform, this will produce a mesh of 
approximately equally sized finite elements. 
 
When the Mesh Type = Uniform, you will be required to specify the Element Type and the 
Approximate Number of Elements, in the Mesh Setup dialog. 
 
 In the example below: 
 
Mesh Type = Uniform 
Approximate Number of Elements = 300 
Element Type = Triangles  
 

 
 
Approximate Number of Elements 
For a Uniform mesh, an Approximate Number of Elements is entered, rather than a 
Gradation Factor and Number of Nodes, because: 

• The Gradation Factor is by definition, equal to 1 for a Uniform mesh.  
• It is more intuitive to specify a total number of elements, rather than the number of 

boundary nodes, for a Uniform Mesh. 
 
Remember that the Approximate Number of Elements is an approximate number. The actual 
number of elements generated is displayed in the status bar after meshing, and will in 
general be different from the Approximate Number of Elements entered in the Mesh Setup 
dialog. 
 



 

 77

Radial Mesh 
A third Mesh Type is available in the Mesh Setup dialog, Radial meshing. Developed mainly 
for testing and verification purposes, it is intended for use with circular (or elliptical) 
excavations – other shapes may produce unpredictable results (you can experiment and see 
what happens). Notice that for a Radial mesh you must enter an Expansion Factor rather 
than a Gradation Factor (see below). Also, there are several modeling restrictions associated 
with a Radial mesh, as described below. 
 
In the example below: 
 
Mesh Type = Radial 
Number of Excavation Nodes = 60 
Expansion Factor = 1.0 
Element Type = Quadrilaterals 
 

 
 
Expansion Factor 
Because of the way in which a Radial mesh is generated, the Mesh Setup dialog will ask 
you for an Expansion Factor rather than the Gradation Factor, when you toggle the Mesh 
Type to Radial. 
 
Note that the Expansion Factor for a Radial mesh in the Mesh Setup dialog is the same as 
the Expansion Factor which is entered for an automatically generated EXTERNAL boundary 
. Since the EXTERNAL boundary generation is integrated with the Radial mesh generation, 
this allows the user to change the Expansion Factor for a Radial mesh without having to 
select the Add External option to access the Create External Boundary dialog. 
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Also note that the Gradation Factor for a Radial mesh is automatic, and cannot be directly 
altered by the user, except by changing the Number of Excavation Nodes. 
 
Creating a Radial Mesh 
Radial meshing was developed mainly for testing and verification purposes, since it gives a 
reproducible*, symmetrical radial mesh for a single symmetrical excavation. You may want 
to use it in cases where you have a symmetrical (preferably circular or elliptical) excavation. 
 
(* For a given discretization, Graded or Uniform meshing will actually produce a different 
mesh each time you re-mesh the model. A Radial mesh will always produce exactly the same 
mesh, for a given discretization.) 
 
Since it is a specialized mesh generation option, there are several restrictions on the use of 
Radial meshing: 
1. Only a single excavation can be present. 
2. MATERIAL, STAGE and JOINT boundaries are not permitted. 
3. In general, it is intended for use with a single, convex, symmetric excavation. 
 
To create a Radial mesh, use the following steps: 
 
1. Create your excavation. 
2. Instead of adding the EXTERNAL boundary, go to the Mesh Setup option and 
toggle the Mesh Type to Radial. Note that for a Radial mesh, an Expansion Factor is entered 
rather than a Gradation Factor. The Expansion Factor has the same effect as the Expansion 
Factor in the Create External Boundary dialog. 
3. Select Discretize to discretize the excavation. 
4. Select Mesh and the Radial mesh will be generated. As you will see, the EXTERNAL 
boundary will appear at the end of the Radial mesh generation. 
5. Although you cannot directly control the Gradation Factor for a Radial mesh, you 
can control the fineness and/or extent of the mesh by changing the Number of Excavation 
Nodes and/or the Expansion Factor in Mesh Setup. 
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Element Type 
The user can choose between 4 different finite Element Types in the Mesh Setup dialog: 
 

• 3 NODED TRIANGLE 
• 6 NODED TRIANGLE 
• 4 NODED QUADRILATERAL 
• 8 NODED QUADRILATERAL 

 
NOTE: 
• If you are using elements with midside nodes (ie. 6 noded triangles or 8 noded 
quadrilaterals), the midside nodes will be displayed on the mesh as small circular dots at the 
midpoint of each finite element edge. The display of the midside nodes can be turned on or off 
at any time, in the Display Options dialog. 
• The user should be aware that using elements with midside nodes will greatly 
increase the size of the matrices used to solve the problem, and will therefore increase 
solution time and memory requirements. 
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Advanced Discretization 
The Advanced Discretization option in the Mesh Setup dialog, allows the user maximum 
flexibility in customizing the discretization of the model boundaries. 
 
In most cases, the regular discretization procedure, of specifying the Number of Excavation 
Nodes for all excavations, and the Gradation Factor, will be sufficient to obtain suitable 
discretization of boundaries. However, with the Advanced Discretization options, the user 
has complete control of the discretization of any part of the model. 
 
Advanced Discretization is only applicable if the Mesh Type = Graded in the Mesh Setup 
dialog. To use Advanced Discretization: 
 
1. Select the Advanced Discretization checkbox, and the Mesh Setup dialog will 
expand to display the Advanced Discretization options. 
2. The Number of Nodes for each individual excavation boundary of your model, can be 
customized by entering the desired number of nodes for any excavation. Note that by default, 
when you initially select Advanced Discretization, the total number of nodes for all 
excavations, will be approximately equal to the Default Number of Nodes for All Excavations, 
in the main part of the Mesh Setup dialog. 
3. User Defined Regions can be created, by using the Add button, to select any 
rectangular region of the model. All boundaries within the User Defined region, can then be 
assigned a Number of Nodes, just like an excavation boundary. 
4. To delete User Defined Regions, use the Delete button. 
5. To reset all Advanced Discretization parameters to the defaults, select the Reset 
button. 
6. Note that the Element Length displays the average Element Length, for each Region 
Type. However, the user may also specify an Element Length. To do this, enter an Element 
Length for the desired Region Type. Then click the mouse anywhere in the grid, and the 
Number of Nodes will be updated, to the required number necessary to achieve the 
approximate Element Length entered. 
 
NOTE: 
• Since the Advanced Discretization option is within the Mesh Setup dialog, all 
Advanced Discretization settings will be preserved, even if the Discretization has been reset 
with the Reset Mesh option in the Mesh menu or the toolbar. 
• The Custom Discretize option in the Mesh menu or toolbar, can also be used to 
specify custom discretizations along model boundaries. However, all custom discretization is 
lost if the Discretization has been reset with the Reset Mesh option in the Mesh menu or 
the toolbar. 
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Discretize 
The Discretize option in the toolbar or the Mesh menu, will discretize all model boundaries, 
according to the settings in the Mesh Setup dialog.  
 
The discretization of the model boundaries, forms the framework for the finite element mesh, 
and is indicated by small red crosses subdividing the boundary line segments. Each cross 
indicates the position of a finite element node on the boundary. The Status Bar will indicate 
the number of discretizations created for each boundary type. You must always select 
Discretize before you can generate the mesh. 
 
If you are not satisfied with the discretization, you can: 
 

1. Change the settings in the Mesh Setup dialog (eg. Number of Nodes, Gradation Factor, 
or use the Advanced Discretization settings), and then re-select Discretize. 

2. Use the Custom Discretize option. 
 
After discretizing, the finite element mesh is generated by selecting the Mesh option. 
 
NOTE: 

• The Discretize option is also available as a button in the Mesh Setup dialog. 
• The Reset Mesh option can be used at any time to reset the mesh and / or discretization. 
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Custom Discretize 
After selecting Discretize , you may need to tailor the discretization on one or more boundary 
line segments. This can be done with the Custom Discretize option. To Custom Discretize: 
 
1. Select Custom Discretize from the toolbar or the Mesh menu. 
2. Use the mouse to select the boundary line segments that you would like to Custom 
Discretize. 
3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will see a dialog. Enter the number of discretizations that you would like to 
apply to EACH selected segment. 
5. Select OK, and all selected line segments will be re-discretized with the number you 
entered in the dialog. 
6. Repeat steps 1-5 if different segments require different discretizations, since only one 
number at a time can be entered as a custom discretization. 
 
Custom Discretize always applies a uniform discretization to the selected line segments, 
using the user-supplied number of discretizations per line segment. This will replace the 
"graded" discretization which exists by default, on boundaries outside of excavation 
boundaries. If you wish to simulate a "graded" discretization along a boundary using 
Custom Discretization, you can insert vertices along a boundary to divide it up into 
smaller segments, and then apply a Custom Discretization to each segment. 
 
NOTE: 
• You must always use the Discretize option first, to produce an initial discretization, 
before you can  Custom Discretize. 
• Before using Custom Discretize, you may want to first try changing the Mesh 
Setup parameters (eg. Number of Excavation Nodes and / or Gradation Factor), and re-
selecting Discretize. This may be sufficient to create a discretization to your liking. 
• Discretization can also be customized using the Advanced Discretization option in the 
Mesh Setup dialog. See the Advanced Discretization topic for details. 
• Anytime the discretization is reset (eg. with the Reset Mesh option), all Custom 
Discretization will be lost. If you accidentally reset a Custom Discretization, remember 
that you can always use the Undo option to Undo any actions in PHASE2. 
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Mesh 
After the boundaries are Discretized, select the Mesh option from the toolbar or the Mesh 
menu, and the finite element mesh will be generated, with no further intervention by the 
user.  
 
The mesh will be generated according to the Mesh Type and Element Type in the Mesh 
Setup dialog. The total number of elements and number of nodes in the mesh will be 
displayed in the Status Bar. 
 
NOTE: 

• The Mesh option is also available as a button in the Mesh Setup dialog. This allows 
you to experiment with different mesh and discretization parameters, and view the 
results, while using the Mesh Setup dialog. 

• After the mesh has been generated, options are available in the Mesh Refinement sub-
menu of the Mesh menu, which allow the user to refine or customize any area of the 
mesh. See the Mesh Refinement topic for details. 

• The Reset Mesh option can be used at any time to reset the mesh and / or discretization. 
 
NOTE TO PHASE2 version 4.0 USERS: 

• As of PHASE2 version 5.0, regions within excavation boundaries, are now always 
meshed, even for single stage models. Previously, for a single stage model, the region 
within an excavation boundary was NOT meshed. This change was made to improve the 
consistency and flow of the PHASE2 modeling procedure. Users will now have to 
excavate regions within excavation boundaries, even for single stage models, with the 
Excavate button in the Assign dialog. 
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Mesh Refinement 
The options in the Mesh Refinement sub-menu of the Mesh menu, provide the user with 
some very powerful options for customizing the finite element mesh, after the mesh has been 
generated. These include: 
 

• Increasing the density of the mesh in any area with the Increase Density option 
• Creating a regular (mapped) mesh in any closed region bounded by 3 segments 

(Mapped Triangular Region) or 4 segments (Mapped Rectangular Region). See 
the Mapped Meshing topic for a discussion of these options. 

• Troubleshooting mesh problems with the Show Mesh Quality and Define Mesh 
Quality options (see the Mesh Quality topic for a discussion of these options) 

 
Remember that these options require that the finite element mesh has already been 
generated, with the Mesh option.  
 
Increase Density 
The Increase Density option allows the user to select any area of the mesh within a 
rectangular window, to increase the density of the mesh within the window. To use this 
option: 
 

1. Select Increase Density from the Mesh Refinement sub-menu of the Mesh menu.  
2. Use the mouse (or the keyboard) to enter two points defining opposite corners of a 

rectangular region, in which you would like to increase the mesh density. 
3. After the second corner of the window has been entered, the density of the mesh within 

the selected region will be automatically increased, according to the following rules: 
• A new node is automatically inserted at the center of each finite element, within the 

selected region. 
• A new mesh is then generated, which uses ALL OF THE ORIGINAL nodes which 

existed, as well as the new nodes inserted at the element centers within the selected 
region. 

 
If the results of using Increase Density are unsatisfactory, remember that you can always 
use the Undo option to Undo any actions in PHASE2, or you can use Increase Density any 
number of times, until the mesh is sufficiently refined. 
 
NOTE: 

• The discretization of the model boundaries is NOT affected by the Increase Density 
option. Only the mesh density within the boundaries is affected. If you need to increase 
or modify the density of nodes on the boundaries, you must do this BEFORE the mesh 
is generated, using either the options in Mesh Setup, or with the Custom Discretize 
option. 
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Mapped Meshing 
There are situations when it is necessary or desirable, to create a geometrically regular finite 
element mesh. This is referred to as "mapped" meshing. In PHASE2, a mapped mesh may be 
created within triangular or rectangular regions, using the Mapped Triangular Region or 
Mapped Rectangular Region options in the Mesh Refinement sub-menu of the Mesh 
menu.  
 
Mapped Triangular Region 
The Mapped Triangular Region option allows the user to create a regular (mapped) mesh, 
within any region bounded by THREE line segments. NOTE: 

• The three line segments must form a closed region 
• Each of the three line segments MUST have the same number of nodes (discretizations). 

In most cases, you will have to use the Custom Discretize option, in order to ensure that 
each line segment has the same number of nodes. 

 
If the above two conditions are met, then you may use the Mapped Triangular Region 
option as follows: 
 

1. Select Mapped Triangular Region from the Mesh Refinement sub-menu of the 
Mesh menu. 

2. Use the mouse to select three boundary line segments which form a closed triangular 
region. 

3. Right-click the mouse and select Done Selection (or press Enter), and a regular mapped 
mesh will automatically be generated, within the triangular region. The mapped mesh 
will be generated according to the discretization of the three line segments, and the 
Element Type in Mesh Setup (Triangles or Quadrilaterals). 

 
Mapped Rectangular Region 
The Mapped Rectangular Region option allows the user to create a regular (mapped) 
mesh, within any region bounded by FOUR line segments. NOTE: 

• The four line segments must form a closed region, and the region must be concave 
(convex regions not allowed). 

• Opposite line segments of the rectangular region, MUST have the same number of 
nodes (discretizations). In most cases, you will have to use the Custom Discretize 
option, in order to achieve this. (Unlike the Mapped Triangular Region option, it is 
not necessary for ALL line segments to have the same discretization). 

 
If the above conditions are met, then you may use the Mapped Rectangular Region option 
as follows: 
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1. Select Mapped Rectangular Region from the Mesh Refinement sub-menu of the 
Mesh menu. 

2. Use the mouse to select FOUR boundary line segments which form a closed rectangular 
region. 

3. When you are finished selecting line segments, right-click the mouse and select Done 
Selection (or press Enter), and a regular mapped mesh will automatically be generated, 
within the rectangular region. The mapped mesh will be generated according to the 
discretization of the four line segments, and the Element Type in Mesh Setup (Triangles 
or Quadrilaterals). 

 
NOTE:  

• Either Triangular or Quadrilateral finite elements may be used with either mapped 
meshing option. However, if Quadrilateral elements are used with a Mapped Triangular 
Region, then some of the elements will necessarily be triangles. 

• If the mesh is reset with the Reset Mesh option, all mapped meshing will be lost. 
However, remember that you can always use the Undo option to Undo any actions in 
PHASE2. 
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Mesh Quality 
In a finite element mesh, it is generally desirable to avoid elements of high aspect ratio (ie. 
long "thin" elements). The presence of such elements can have adverse effects on the analysis 
results. 

• In general, such elements can influence analysis results, and lead to misleading and 
inaccurate results, which are dependent on the mesh. 

• In extreme cases, such elements may even be responsible for non-convergence of the 
finite element solution, and the analysis will be aborted. 

 
In order to help the user determine the "quality" of a finite element mesh, PHASE2 can 
automatically locate and highlight elements in a mesh, which are deemed to be of "poor" 
quality, according to user-definable criteria. 
 
This is done with the Show Mesh Quality and Define Mesh Quality options, in the Mesh 
Refinement sub-menu of the Mesh menu. 
 
Show Mesh Quality 
In order to locate and highlight poor quality elements in a mesh, select the Show Mesh 
Quality option in the Mesh Refinement sub-menu of the Mesh menu. If poor quality 
elements exist: 
 

• All poor quality elements will be filled with a red hatch pattern 
• Since these elements will often be difficult to see, without zooming in to view, the 

general area(s) where poor quality elements have been found, will be additionally 
highlighted, by blue rectangular boxes drawn around the regions of poor quality 
elements. The display of these boxes can be turned off if desired, by de-selecting the 
Highlight checkbox in the Define Mesh Quality dialog. 

 
The elements which are highlighted, are those which conform to the criteria of a "poor 
quality" element, as defined in the Define Mesh Quality dialog. In most cases, you will 
need to zoom in to get a good view of the highlighted poor quality elements, and determine 
what may be the cause of the problem. 
 
Define Mesh Quality 
The Define Mesh Quality dialog allows the user to specify the criteria which define a "poor 
quality" element. There are three criteria which may be specified: 
 

• ratio of (maximum side length) / (minimum side length) 
• Minimum interior angle 
• Maximum interior angle 



 

 88 

 
The defaults for the above criteria, are 10 , 20 and 120, respectively. However, the user may 
change any of these criteria. NOTE that an element will be determined as "poor quality", if 
ANY of these three criteria are met. 
 
Highlight 
By default, the Highlight checkbox is toggled ON in the Define Mesh Quality dialog. This 
option draws an additional blue rectangle around regions of poor quality elements, since in 
many cases the poor quality elements may be difficult to see, even with the red hatch fill, 
unless you are zoomed in to that region of the mesh. If you do not wish to see these blue 
rectangles displayed, then you can turn the Highlight option OFF by clearing the checkbox. 
 
Number of divisions for statistics 
Statistics for poor quality elements can be found listed in the Info Viewer. These statistics 
allow the user to examine the quantity and distribution of poor quality elements, for each of 
the three quality criteria. The Number of divisions for statistics in the Define Mesh Quality 
dialog, allows the user to define the number of divisions used for calculating the distributions 
tabulated in the Info Viewer. For a demonstration of this, it is suggested that the user view 
the Mesh Quality statistics listed in the Info Viewer. 
 
Reasons for poor quality mesh elements 
There are various reasons why poor quality mesh elements may be generated. Typically the 
problems are due to: 

1. Poorly graded discretization of model boundaries (for example, a finely discretized 
boundary immediately adjacent to, or close to, a coarsely discretized boundary, will 
often result in a poor quality mesh). 

2. Vertices which are very close to each other. This can happen when a boundary has been 
intersected with another boundary, without using vertex snap, such that two vertices 
end up very near to each other, when the user may have intended both vertices to be at 
the same location. Due to the automatic boundary intersecting capability of PHASE2, 
this may occur without the user being aware of it. 

3. The geometry of your model boundaries may also be responsible, for example, the 
relative distances between boundaries, or the way in which they intersect (eg. nearly 
parallel boundaries which intersect at a very small angle). 

 
Fixing a poor quality mesh 

1. If a poor discretization is responsible for the poor mesh, then you will need to reset the 
mesh, and modify the discretization of the appropriate boundaries. This may involve 
use of the Custom Discretize option, or the Advanced Discretization option in the Mesh 
Setup dialog, or simply changing the main Mesh Setup parameters (eg. Number of 
Excavation Nodes, Gradation Factor) 

2. If the problem is vertices which are very close to each other, then you may need to 
delete unnecessary vertices, or move vertices, so that they are further apart, or exactly 
coincident. If vertices were intentionally located very near to each other, and this is 
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causing a problem, then you may want to consider modifying your geometry slightly, so 
that poor quality elements are not generated. 

3. If the actual model geometry is responsible, then various solutions might be 
appropriate, involving Custom Discretize, or modifying the boundaries slightly, so 
that the problem does not occur. 

 
 
Reset Mesh 
To reset the finite element mesh and / or the discretization, select Reset Mesh from the 
toolbar or the Mesh menu. 
 
Resetting the mesh is separated into two steps: 

1. Resetting the mesh. 
2. Resetting the discretization. 

 
This is because there will be times when you only want to reset the mesh, but not the 
discretization. For example: 

• you may want to preserve a Custom Discretization for further customizing (remember 
that all Custom Discretization is lost when the discretization is reset), or 

• you may only want to change the Element Type from triangles to quads, or vice versa, 
but retain the same discretization. 

 
Tips 

• If the model has been discretized but not meshed, then Reset Mesh will reset the 
discretization only. 

• Reset Mesh does not reset any of the Mesh Setup options, these can only be changed 
through the Mesh Setup dialog. 

• If you are using the Radial mesh type, then Reset Mesh will also delete the 
EXTERNAL boundary when the mesh is reset, since this is integrated with the Radial 
mesh generation. 

• If your model includes support (ie. BOLTS or LINERS ), then Reset Mesh will delete 
all support as well as the mesh. This is because the support must be defined after the 
mesh is generated in PHASE2.  

• If you delete the mesh or support accidentally, remember that you can always use the 
Undo option to Undo any actions in PHASE2. Also, note that BOLT geometry can be 
saved to a DXF file , and then read back in again – you may find this useful for saving 
complex bolting patterns. 
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Field Stress 
The Field Stress option, in the toolbar or the Loading menu, allows the user to define the 
in-situ stress conditions prior to excavation. Two options are available for defining field 
stress in PHASE2, Constant or Gravity field stress. 
 
Constant Field Stress 
The Constant field stress option is used to define a constant stress field prior to excavation 
(ie. one which does not vary with position). See the Constant Field Stress topic for details. 
 
Gravity Field Stress 
The Gravity field stress option is used to define a gravity stress field which varies linearly 
with depth from a user-specified Ground Surface Elevation. Gravity field stress is typically 
used for surface or near surface excavations. See the Gravity Field Stress topic for details. 
 
Custom Field Stress 
For either Constant or Gravity field stress, the field stress for individual materials may be 
customized, if necessary, by selecting the Advanced button in the Field Stress dialog, and 
specifying the field stress for any material(s) in the model. See the Custom Field Stress topic 
for details. 
 
Stress Block 
The relative magnitude and direction of the In Plane principal field stresses, are indicated by 
the Stress Block, displayed in the upper right corner of the view. If the Stress Block looks 
wrong then make sure you have correctly entered field stress parameters (ie. Sigma 1, Sigma 
3 and Angle, for a Constant field stress, or the Horizontal / Vertical In Plane Stress Ratio, for 
Gravity field stress). The display of the Stress Block can be toggled on or off with the Stress 
Block option in the View menu. 
 
Load Splitting 
If your model is staged (ie. the Number of Stages in the Project Settings dialog is greater 
than 1), then by default, 100% of the field stress induced load is applied to the model in the 
FIRST stage. However, for staged models, the user has the option of "splitting" the field 
stress induced load, between any desired stages of the model (rather than applying the entire 
load in the first stage). This is done with the Load Split option in the Loading menu, see 
the Load Split topic for details. 
 
Also note: 

• In PHASE2 it is assumed that the stress field is aligned with the analysis section – ie. 
one of the three in-situ principal stresses must be aligned with the longitudinal axis of 
the excavation. A fully 3-dimensional, arbitrarily oriented stress field cannot be entered 
in PHASE2. 
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• Since the yield functions used in the COMPUTE engine are three-dimensional (ie. they 
depend on all components of the stress tensor) it is important that the user enters a 
stress (or stress ratio) in the out-of-plane direction. 

• The convention for stress is POSITIVE COMPRESSION, so in most cases you will be 
entering positive values for stresses. 
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Constant Field Stress 
Use the Constant field stress option to define a constant stress field prior to excavation (ie. 
one which does not vary with position). In the Field Stress dialog, the following parameters 
are required to define a Constant field stress: 
 
Sigma 1 
Sigma 1 is the MAJOR IN-PLANE principal field stress. 
 
Sigma 3 
Sigma 3 is the MINOR IN-PLANE principal field stress. 
 
Sigma Z 
Sigma Z is the OUT-OF-PLANE field stress. 
 
Angle 
The Angle is measured between the positive x-axis and the direction of Sigma 1. The Angle is 
measured in degrees, and the counter-clockwise direction is defined as positive.  

NOTE: Remember that the Stress Block indicates the relative magnitude and direction of the 
In-Plane principal field stresses. If the Stress Block looks wrong then try entering the field 
stress data again, keeping in mind the definition of Angle. The  display of the Stress Block 
can be toggled on or off in the View menu. 
 
Custom Field Stress 
Customized field stress may be defined for individual materials in a model, by selecting the 
Advanced button, and defining custom field stress as required. See the Custom Field Stress 
topic for details. 
 
Axisymmetric Constant Field Stress 
If you are modeling an AXISYMMETRIC problem (this is set in the Project Settings dialog), 
then the Field Stress dialog will ask you for: 
 

• Horizontal Stress 

• Vertical Stress 

 
(rather than Sigma 1, Sigma 3, Sigma Z and Angle). 
 
It is very important to note that Vertical and Horizontal refer to the setup of your problem in 
PHASE2, and not necessarily the true orientation of your excavation. The Vertical stress is 
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the stress in the axial direction (ie. the axis of rotational symmetry), and the Horizontal 
stress is the field stress perpendicular to the axis of symmetry. The terms Vertical and 
Horizontal are used, because in PHASE2, an axisymmetric model must always be defined 
such that the axial direction is oriented with the y-axis of the coordinate system. 
 
Out-of-plane (or circumferential) field stress exists, but is automatically set equal to the 
Horizontal (or radial) stress, and cannot be independently varied by the user. 
 
See the PHASE2 User’s Guide for a tutorial on AXISYMMETRIC modeling. 
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Gravity Field Stress 
The Gravity field stress option is used to define a gravity stress field which varies linearly 
with depth from a user-specified Ground Surface Elevation. Gravity field stress is typically 
used for surface or near surface excavations. In the Field Stress dialog, the following 
parameters are required to define a Gravity stress field: 
 
Ground Surface Elevation 
The Ground Surface Elevation is the vertical (y) coordinate of the ground surface with 
respect to your coordinate system. It is NOT the depth below ground surface of your 
excavations! 
NOTE: When you are using Gravity field stress, a horizontal dotted line marking the Ground 
Surface Elevation will automatically be displayed on the model. The display of this line can 
be toggled on or off in the View menu. 
 
Unit Weight of Overburden 
The Unit Weight Of Overburden (note units: MN / m3) is used, in conjunction with the 
Ground Surface Elevation, to calculate the vertical component of the gravitational field 
stress, at any point in the model. 
 
Stress Ratios 
The Horizontal / Vertical stress ratios (In-Plane and Out-Of-Plane), are used to calculate the 
horizontal components of the gravitational field stress, based on the vertical component at 
any point in the model. 
NOTE: Remember that the Stress Block indicates the relative magnitude and direction of the 
In-Plane principal field stresses. For a Gravity field stress, the Stress Block is always 
oriented with the vertical and horizontal axes. If the Stress Block looks wrong then check 
the value of the In-Plane Horizontal / Vertical Stress Ratio. 
 
Locked In Stress 
You may also include horizontal Locked In stress components in the In Plane and / or Out-Of-
Plane directions. A Locked In stress component means that the horizontal field stress will be 
equal to the Locked In stress at the Ground Surface Elevation, and this fixed component of 
stress will be added to the horizontal field stress, below the Ground Surface Elevation, to 
determine the total horizontal stress at any point. 
 
Custom Field Stress 
Customized field stress may be defined for individual materials in a model, by selecting the 
Advanced button, and defining custom field stress as required. See the Custom Field Stress 
topic for details. 
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Custom Field Stress 
There are situations when it is required that the user be able to specify the field stress for 
individual materials in a model, rather than only a single field stress which applies to all 
materials. 
 
For example, individual layers of material in bedded geological structures, will sometimes 
have a field stress which is different from the field stress in surrounding layers. When this 
situation occurs, the user can define a customized field stress for any material(s) in their 
model, as follows: 
 

1. In the Field Stress Properties dialog, select the Advanced button. 
2. The dialog will expand, allowing the user to define a customized field stress, for any 

material(s) in their model. Note that the materials in the Field Stress Properties 
dialog, correspond to the materials you have defined in the Define Material Properties 
dialog. 

3. To define customized field stress for a material, select the Apply Custom Field Stress 
checkbox, for the desired material, and enter the field stress parameters which apply to 
the material. 

4. Repeat Step 3, for each material which requires a custom field stress.  
 
NOTE: the default field stress properties, in the main (upper) part of the Field Stress 
Properties dialog, will still apply to all materials which have NOT had custom field stress 
properties specified. 
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Load Splitting 
By default in PHASE2, the entire load on the model due to Field Stress, is applied in the first 
stage of the model.  
 
The Load Split option in PHASE2 allows the user to "split" the field stress induced load, 
between any stages of the model, rather than applying the entire field stress load in the first 
stage. A typical use of Load Splitting, is to simulate the delayed installation of support, as 
discussed at the end of this topic. 
 
To implement Load Splitting in PHASE2: 
 

1. First note that the Load Split option is only applicable, and is only enabled if your 
model is STAGED (ie. the Number of Stages in the Project Settings option is greater 
than 1). 

2. Select Load Split from the Loading menu. 
3. In the Load Split dialog, select the Enable Load Split checkbox. 
4. Enter the Load Split information at each stage (Split Factor and Stress Behaviour) as 

described below. 
 
Split Factor 
A Split Factor may be defined at each stage of the model. The Split Factor is used as follows: 

• The Split Factor is simply multiplied by the values of the Field Stress, to obtain the 
actual Field Stress which will be applied at that stage.  

• In most cases, a Split Factor will be a number between 0 and 1. However, in the 
interests of generality, numbers greater than 1 may be entered (this allows you to 
increase the Field Stress entered in the Field Stress dialog), or even negative numbers 
may be entered (allowing you to decrease field stress). 

• For example, if you were using a Constant Field Stress with Sigma 1 = 20, and Sigma 3 
= Sigma Z = 10, and the Split Factor = 0.5 at a given stage, then the actual Field Stress 
which will be applied at that stage, will be Sigma 1 = 10, and Sigma 3 = Sigma Z = 5. 

• The Field Stress will be applied to the model according to the Stress Behaviour (ie. 
Initialize or Add, see below for details).  

 
Stress Behavior 

• When the Stress Behaviour = Initialize, the Field Stress at that stage will be 
INITIALIZED to the value determined by the Split Factor at that stage.  

• When the Stress Behaviour = Add, the Field Stress determined by the Split Factor, will 
be ADDED to the existing stress state of the model, at the indicated stage. 

NOTE:  
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• By default, for all materials, the Stress Behaviour = Initialize at Stage 1, and Stress 
Behaviour = Add in all subsequent stages. The user cannot change this. However, with 
Custom Load Splitting (see below), the user may define the Stress Behaviour (Initialize 
or Add), for any material in the model, at any stage. 

 
Custom Load Split 
To allow the user maximum flexibility in defining a Load Split, the Custom Load split option 
is available, which allows the user to define Split Factor and Stress Behaviour on a per 
material basis. To define a Custom Load Split: 
 

1. Select the Advanced button in the Load Split dialog. 
2. The dialog will expand, allowing the user to define a customized Load Split, for any 

material(s) in their model. Note that the materials in the Load Split dialog, correspond 
to the materials you have defined in the Define Material Properties dialog. 

3. To define a Custom Load Split for a material, select the Custom Load Split checkbox, 
for the desired material, and enter the Split Factor and Stress Behaviour information 
for the material. 

4. Repeat Step 3, for each material which requires a Custom Load Split.  
 

NOTE: the default Load Split information, in the main (upper) part of the Load Split dialog, 
will still apply to all materials which have NOT had a Custom Load Split specified. 
 
Typical Use of Load Split 
A typical use of Load Splitting, is to simulate the delayed installation of support. For 
example, in a simple two stage model of an excavation: 
 

• You could set the Split Factor = 0.3 in Stage 1 and Split Factor = 0.7 in Stage 2. 
• Install support (eg. bolts and / or liners) in Stage 2. 

 
When you run the analysis, only 30% of the total Field Stress load will be applied in the first 
stage. Effectively, this allows some displacement to take place in the first stage, without 
support, simulating the delayed installation of support at the face of an advancing tunnel, for 
example. Then, support installed in the second stage can react to the remainder (70%) of the 
field stress load.  
 
An example of the use of load splitting can be found in the "Support Tutorial" in the PHASE2 
User’s Guide. 
 
Other uses of the Load Split option are also possible, due to the general formulation of the 
Load Split / Custom Load Split option in PHASE2. 
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Seismic Loading 
The Seismic Loading option in the Loading menu allows the user to include the effect of 
pseudo-static earthquake loading in the finite element analysis.  
 
In the Seismic Load dialog, the user may define seismic coefficients for the Horizontal and / 
or Vertical directions.  
 
The Seismic Coefficients are dimensionless coefficients which represent the (maximum) 
earthquake acceleration as a fraction of the acceleration due to gravity. Typical values are in 
the range of 0.1 to 0.3. 
 
Seismic Force 
If seismic coefficients are defined, a seismic Body Force will be applied to each finite element 
in the mesh. The seismic force which is applied to each finite element is as follows: 
 

     Seismic Force = Seismic Coefficient * area of element * Unit Weight of element material 
 
Note that the acceleration due to gravity (g = 9.81 m/s2) is already incorporated into the Unit 
Weight of Material (remember that the dimensions of Unit Weight are MN / m3), and 
therefore does not explicitly appear in the above equation. (The Unit Weight of material is 
the Unit Weight which is defined for each material in the Define Material Properties dialog, 
when Body Force is included with the Initial Element Loading, see below for details). 
Alternatively, the seismic force equation can be expressed as: 
 
     Seismic Force = Seismic Coefficient * Body Force (due to gravity) 
 
NOTE: 

• Body Force (due to gravity) simply represents the self-weight of a finite element.  
• It is very important to note that Seismic Force only applies to materials which have an 

Initial Element Loading which includes Body Force. Initial Element Loading is specified 
in the Define Material Properties dialog. See the Initial Element Loading topic for more 
information. 

• The Seismic Force will be applied as an additional Body Force to each element, and is 
vectorially added to the downward Body Force which exists due to gravity. 

• If Body Force is NOT included in the Initial Element Loading, then the applied Seismic 
Force will be ZERO, even if seismic coefficients are defined in the Seismic Load dialog. 
You must remember this if you want to use Seismic Load in combination with Constant 
Field Stress, since by default, the Initial Element Loading for Constant Field Stress is 
Field Stress Only. 

 
Finally note the direction conventions –  
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• a POSITIVE Horizontal coefficient represents a force applied to the RIGHT.  
• a NEGATIVE Horizontal coefficient represents a force applied to the LEFT.  
• A POSITIVE Vertical coefficient represents a force applied UPWARDS.  
• A NEGATIVE Vertical coefficient represents a force applied DOWNWARD.  

 
When carrying out a finite element analysis with Seismic Loading, you should run multiple 
analyses using different combinations and directions of Horizontal and Vertical seismic 
coefficients, in order to evaluate the effect of seismic force direction on the analysis results 
(eg. stresses, displacements, strength factor etc). 
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Tractions Overview 
In PHASE2 you can apply tractions (ie. distributed surface loads) to EXCAVATION, 
EXTERNAL, MATERIAL or STAGE boundaries. In a multi-stage model, tractions can be 
staged. 
 
There are three different options available for applying tractions in PHASE2: 
 

• NORMAL / SHEAR  
• HORIZONTAL / VERTICAL  
• ANGLE  

 
These options allow the user to choose the most convenient way of applying a load to a 
boundary. However, note that a given load could be specified using any one of the three 
options.  
 
Traction Units 
Although traction magnitudes are entered as MN / m, in reality they represent surface loads 
in MN / m2, when considering the out-of-plane dimension. For a Plane Strain model, each 
traction therefore represents an infinite strip load. 
 
NOTE: 

• Tractions cannot be applied until the finite element mesh has been generated. 
• If the mesh is reset, all existing tractions will be automatically deleted. If you 

accidentally reset the mesh, remember that you can always Undo any actions in 
PHASE2 with the Undo option in the Edit menu. 
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Normal / Shear Traction 
In the majority of cases, you will simply want to add a NORMAL surface load to a boundary. 
The easiest way to do this is with the Normal / Shear tractions option: 
 

1. Select Normal / Shear from the toolbar, or the Tractions sub-menu of the Loading 
menu. 

2. In the dialog you will see, enter the magnitudes of the Normal and Shear components of 
your traction, and note the sign conventions. In most cases you will probably want to 
add a Normal traction only. To do this, enter a Normal magnitude, and leave the Shear 
component = 0. 

3. In a multi-stage model, tractions can be staged by selecting the Stage traction checkbox, 
and entering a Factor for the load magnitude at each stage. If you do NOT stage the 
traction on a multi-stage model, then by default it will be applied, with the same 
magnitude, at all stages. See below for details.  

4. Select OK in the dialog, and you will be prompted to select the boundary line segment(s) 
on which to apply the traction. Remember you can select EXCAVATION, EXTERNAL, 
MATERIAL or STAGE boundary segments. 

5. When finished selecting, press Enter or right-click and select Done Selection, and your 
traction will be applied to all selected segment(s), as indicated by the display of red 
arrows and the magnitude. 

6. Check the direction of the arrows and the magnitude, to make sure that this is the 
traction you wished to apply. If there is a mistake, repeat steps 1 to 5 and make sure 
the Normal and Shear magnitudes are correct. Note that minus signs can be used in 
front of the magnitudes, to change the direction of the Normal or Shear components. 

 
Staging Tractions 
On a multi-stage model, tractions can easily be staged by selecting the Stage traction 
checkbox in the Traction dialog (Step 3 above), and entering appropriate factors for the load 
magnitude at each stage. NOTE: 
 

• Factor = 1 means that the load magnitude will be equal to the magnitude(s) entered in 
the Traction dialog. 

• You can increase or decrease the load magnitude of the traction at any stage, by 
entering a Factor greater than or less than 1 (eg. a Factor = 2 would double the load 
magnitude). 

• You can remove the traction at any stage, by entering a Factor = 0. The traction will not 
exist at any stage in which the Factor = 0, and will not appear on the model. 

 
If your traction is staged, it is a good idea to select the Stage tabs, after adding the traction, 
to check that the traction is applied at the correct stages, and that the magnitudes are 
correct. If not, then repeat Steps 1 to 5 (above), and make sure that the correct Factors have 
been applied at the correct stages. 
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NOTE: 
• The display of tractions (ie. the red arrows) can be turned off in the Display Options 
dialog. Whenever you add or delete tractions, all existing tractions will be automatically 
displayed, even if they were turned off in Display Options. 
 
Horizontal / Vertical Traction 
If you want to apply HORIZONTAL or VERTICAL tractions to boundaries, regardless of the 
boundary orientation, then use the Horizontal / Vertical tractions option. 
 
To apply a HORIZONTAL / VERTICAL traction, see the information in the Normal / Shear 
Traction topic, as the procedure for applying the traction is the same. However note the 
following points about the Horizontal / Vertical traction option: 
 

1. Enter a Vertical component of zero if you only want to apply a HORIZONTAL traction. 
2. Enter a Horizontal component of zero if you only want to apply a VERTICAL traction 

(this can be useful for modeling a gravity load on a non-horizontal ground surface, for 
example). 

3. If both components are non-zero, loads at any orientation can be defined. 
 
Angle Traction 
You can use the Angle tractions option if your load is in terms of a magnitude and an angle, 
rather than NORMAL / SHEAR or HORIZONTAL / VERTICAL components. 
 
To apply an Angle traction, see the information in the Normal / Shear Traction topic, as the 
procedure for applying the traction is the same. However note the following points about the 
Angle traction option: 
 

1. Only one load magnitude and an angle are required. 
2. The angle can be specified as either Global or Local with the Angle Definition Type in 

the Angle Tractions dialog.  
• For a Global angle, the angle is specified with respect to the global axes, and the 

convention is degrees counter-clockwise from the "down" axis.  
• For a Local angle, the angle is specified with respect to the boundary orientation, and 

the convention is degrees counter-clockwise from the normal "into" the rock. 
3. It is particularly important when using the Angle traction option, to verify that the 

correct traction has been applied, since errors can easily be made when deciding on the 
angle to use for the correct orientation. Check the direction and magnitude of the red 
arrows displayed after the traction is applied, and make sure it is what you intended. 
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Traction Examples 
Note that any of the three Tractions options – Normal / Shear, Horizontal / Vertical or 
Angle – can be used to define any given traction. Which option is used is a matter of 
convenience, or user preference. Depending on the situation, it will generally be more 
convenient to use one option over the others. 
 
To illustrate this, refer to the figure below, which shows three loads of equal magnitude, at 
varying angles. 

 
 
The input values which could be used to create these loads are listed below, for each of the 
three traction options. 
 

 + 45 deg. load 0 deg. load - 45 deg. load 

Normal / Shear Normal = .707 
Shear = .707 

Normal = 1 
Shear = 0 

Normal = .707 
Shear = -.707 

Horizontal / 
Vertical 

Horiz = .707 
Vertical = .707 

Horiz = 0 
Vertical = 1 

Horiz = -.707 
Vertical = .707 

Angle Magnitude = 1 
Angle = + 45 

Magnitude = 1 
Angle = 0 

Magnitude = 1 
Angle = - 45 

 
Note: because the surface in the above example is horizontal, either Global or Local angle 
conventions would produce the same results with the Angle traction option. This would NOT 
be the case for any other angle of surface. 
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Modifying Tractions 
To modify an existing traction (or correct a mistake), simply add a new traction to the same 
line segment(s). You do not have to delete the existing traction, since every time you add a 
traction to a line segment, the previous one is automatically erased and the new one is in 
effect. 
 
If you wish to completely remove a traction, then use the Delete Tractions option. 
 
Deleting Tractions 
To delete tractions from the model: 
 

1. Select Delete Tractions from the toolbar, or the Tractions sub-menu of the Loading 
menu. 

2. Tractions are deleted by selecting the boundary line segments on which they are 
applied. Select the line segments which have the tractions you wish to delete, and press 
Enter or right-click and select Done Selection. Tractions on all selected line segments 
will be removed. 

 
Tips 

• To delete a traction on a multi-stage model, you can select a boundary line segment at 
any stage, and the traction will be deleted for ALL stages. 

• If you want to modify an existing traction, simply add a new traction to the same line 
segment(s). You do not have to delete the existing traction, since every time you add a 
traction to a line segment, the previous one is automatically erased and the new one is 
in effect. 
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Add Nodal Force 
You can add a point load to any node of the finite element mesh using the Add Nodal 
Forces option. To add a nodal force: 
 

1. Select Add Nodal Forces from the Forces sub-menu of the Loading menu. 
2. You will see a dialog allowing you to enter x and y force components. Enter the required 

forces, and note the units (MN) and sign conventions. A minus sign can be used to 
specify a force in the negative x or y directions. 

3. In a multi-stage model, forces can be staged by selecting the Stage Nodal Forces 
checkbox, and entering a Factor for the force magnitude at each stage. If you do NOT 
stage the force on a multi-stage model, then by default the force will be applied, with 
the same magnitude, at all stages. See below for details. 

4. Now select the node(s) on which to apply the force. You can select any node of the mesh, 
including nodes within the rockmass. Note that multiple nodes can be selected with a 
window. As soon as node(s) are selected, the force is applied, as you will see by the 
arrow symbol, and the force component magnitudes. 

5. When you are finished applying the forces, press Escape or right-click and select Done. 
6. Whenever you add a nodal force, all existing nodal forces will be automatically 

displayed. The display of nodal forces (ie. the arrow symbols) can be turned off in the 
Display Options dialog. 

 
Staging Nodal Forces 
On a multi-stage model, forces can be staged by selecting the Stage Nodal Forces checkbox in 
the Nodal Forces dialog (Step 3 above), and entering appropriate factors for the force 
magnitude at each stage. NOTE: 
 

• Factor = 1 means that the force magnitude will be equal to the magnitude(s) entered in 
the Forces dialog. 

• You can increase or decrease the magnitude of the force at any stage, by entering a 
Factor greater than or less than 1 (eg. a Factor = 2 would double the force magnitude). 

• You can remove the force at any stage, by entering a Factor = 0. The force will not exist 
at any stage in which the Factor = 0, and will not appear on the model. 

 
If your force is staged, it is a good idea to select the Stage tabs, after adding the force, to 
check that the force is applied at the correct stages, and that the magnitudes are correct. If 
not, then repeat Steps 1 to 5 (above), and make sure that the correct Factors have been 
applied at the correct stages. 
 
Force Units 
Although force magnitudes are entered as MN, in reality they represent line loads in MN / 
m, when considering the out-of-plane dimension. For a Plane Strain model, each force 
actually represents an infinite line load. 
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Delete Nodal Force 
To delete nodal forces: 
 

1. Select Delete Nodal Forces from the Forces sub-menu of the Loading menu. 
2. Select the nodes on which the forces are applied, and the forces will be immediately 

deleted. Note that multiple nodes can be selected with a window, for the purposes of 
deleting nodal forces. 

3. When you are finished deleting the forces, press Escape or right-click and select Done. 
 
Tips 

• To modify existing nodal forces, simply add a new nodal force to a node. The previous 
one will be automatically erased and the new one will be in effect. 

• On a multi-stage model, nodal forces will be deleted at all stages, regardless of the stage 
at which the node was selected. 

• All nodal forces are automatically displayed when you select Delete Nodal Forces. 
The display can be toggled on or off at any time, in the Display Options dialog. 
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Add Springs 
Springs can be added to any node of the finite element mesh using the Add Springs option.  
 
Springs can be used, for example, to model the effect of struts used for support. 
 
To add springs: 
 

1. Select Add Springs from the Springs sub-menu of the Loading menu. 
2. In the Spring Properties dialog, enter the following information, and select OK: 

• Initial Forces in the x and y directions. 
• Spring Stiffness in the x and y directions 
• Stage In / Stage Out (staged models only), if you want to specify the stage at which 

springs are installed / uninstalled. 
3. Now select the node(s) on which to apply the spring(s). You can select any node of the 

mesh, including nodes within the rockmass. Note that multiple nodes can be selected 
with a window. As soon as node(s) are selected, the spring is applied, as you will see by 
the spring symbol, and the force and stiffness values. 

4. When you are finished applying the springs, press Escape or right-click and select Done. 
5. Whenever you add springs, all existing springs will be automatically displayed. The 

display of springs can be turned on or off with the Forces checkbox in the Display 
Options dialog.  

 
Note that if you used Stage In / Stage Out in the Spring Properties dialog to customize the 
staging of the spring installation, the springs are only displayed at stages where they exist 
(ie. a spring will NOT be displayed if the viewed stage is LESS THAN Stage In or GREATER 
THAN OR EQUAL TO Stage Out). 
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Delete Springs 
To delete springs: 
 

1. Select Delete Springs from the Springs sub-menu of the Loading menu. 
2. Select the nodes on which the springs are applied, and the springs will be immediately 

deleted. Note that multiple nodes can be selected with a window, for the purposes of 
deleting springs. 

3. When you are finished deleting springs, press Escape or right-click and select Done. 
 
Tips 

• To modify existing springs, simply add a new spring to a node. The previous one will be 
automatically erased and the new one will be in effect. 

• On a multi-stage model, a spring will be deleted from a node even if the spring does not 
exist at the stage being viewed (ie. if the viewed stage is < Stage In or >= Stage Out, as 
defined in the Spring Properties dialog when the spring was added to the model). You 
should keep this in mind when using Delete Springs on multi-stage models with 
staged spring installation. 

• All springs are automatically displayed when you select Delete Springs. The display of 
springs can be toggled on or off with the Forces checkbox in the Display Options dialog. 
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Restraints Overview 
The Restraints menu options allow the user to apply the following boundary conditions: 
 

• Fixed XY (ie. pinned) 
• Fixed X (ie. free to move in the Y direction only) 
• Fixed Y (ie. free to move in the X direction only) 
• Free (ie. free in both X and Y directions) 

 
anywhere on the model. In addition: 
 

• A fixed, non-zero displacement can be applied as a boundary condition using the Add 
Displacement option. 

• Infinite Elements can be used on the EXTERNAL boundary. This is set in the Restraint 
Options dialog. 
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Restraint Options 
The Restraint Options dialog has two purposes: 
 
1. The Apply Restraints options, allow the user to choose the most appropriate method 
for applying the restraint boundary conditions, when using the Restrain X, Restrain Y, 
Restrain XY, Free, or Displacement restraint options: 
• Pick by boundary segment – Restraints are applied to entire boundary segments (ie. 
only boundary segments can be selected, and boundary conditions will be applied to all nodes 
of the selected segments). This is the default method. 
• Pick by boundary node – Individual nodes on boundaries can be selected. This is 
useful, for example, when you want to select multiple nodes on a boundary with a selection 
window, without selecting internal mesh nodes. 
• Pick by any node – Any node of the mesh can be selected, including internal nodes. 
 
2. The Default External Boundary option determines what boundary conditions will be 
in effect, by default, on the EXTERNAL boundary: 
• Fixed / Pinned – all EXTERNAL boundary nodes will be given Fixed XY conditions 
(this can then be customized using the Restrain X, Restrain Y or Free options, if 
necessary). 
• Infinite Elements – the EXTERNAL boundary conditions will be modeled using 
Infinite Elements  
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Infinite Elements 
In the Restraint Options dialog, you may choose to model the EXTERNAL boundary 
conditions by the use of Infinite Elements.  
 
Infinite Elements are an alternative to the use of fixed boundary conditions on the 
EXTERNAL boundary. They allow the user to solve a problem with a potentially much 
smaller finite element mesh, and still obtain good results. 
 
In two dimensions, infinite elements extend to infinity in one direction, and allow the 
displacement to decay gradually from the external boundary toward the infinite domain – 
the shape functions for these elements are chosen such that the displacement at the node 
located at infinity is zero. 
 
A discussion of infinite elements can be found in the book "Numerical Methods in Rock 
Mechanics" by G.N. Pande, G. Beer & J.R. Williams, John Wiley and Sons, Ltd., 1990. 
 
NOTE: 

• Infinite Elements are represented by arrows radiating from the EXTERNAL boundary 
nodes, when Restraints are displayed on the model, in the Display Options dialog. 
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Applying Restraints 
To apply restraints to a model: 
 

1. If necessary, use the Restraint Options dialog to set the selection mode for applying the 
restraints. (Selection mode can also be toggled in the right-click menu, see below). 

2. Select the restraint option you would like to apply (Restrain X , Restrain Y , Restrain 
XY or Free ) from the toolbar or the Restraints menu. 

3. If the Apply Restraints option in the Restraint Options dialog is set to Pick by 
boundary segment, pick the desired boundary line segments, and when you are finished, 
press Enter or right-click and select Done Selection. The restraint option you are using 
will be applied to all nodes of the selected segments. 

4. If the Apply Restraints option in the Restraint Options dialog is set to Pick by 
boundary node or Pick by any node, then pick the desired nodes (individually with the 
cursor, or pick multiple nodes with a selection window), and the restraint option you are 
using will be applied immediately to the selected nodes. When you are finished, press 
Escape, or right-click and select Done. 

5. Whenever you use Restrain X, Restrain Y, Restrain XY or Free, all existing 
restraints (ie. roller and pin symbols) will be displayed on the model, if they are not 
already displayed. The display of restraints can be toggled on or off at any time in the 
Display Options dialog. 

 
Tips 
While you are applying restraints, the selection mode can be toggled in the right-click menu 
(ie. Pick by boundary segment, Pick by boundary node, Pick by any node). This allows you to 
change the selection mode on the fly, without having to use the Restraint Options dialog. 
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Restrain X 
The Restrain X option is used to apply zero X-displacement boundary conditions.  
 
The nodes will be free to move in the Y direction only. The X displacement will be fixed at 
zero throughout the analysis. 
 
Nodes restrained in the X direction are indicated by vertical "roller" symbols, when 
Restraints are displayed, as configured in the Display Options dialog. 
 
See the Applying Restraints topic for information about applying restraints. 
 
Restrain Y 

The Restrain Y option is used to apply zero Y-displacement boundary conditions.  
 
The nodes will be free to move in the X direction only. The Y displacement will be fixed at 
zero throughout the analysis. 
 
Nodes restrained in the Y direction are indicated by horizontal "roller" symbols, when 
Restraints are displayed, as configured in the Display Options dialog. 
 
See the Applying Restraints topic for information about applying restraints. 
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Restrain XY 
The Restrain XY option is used to apply pinned boundary conditions. 
 
The nodes will not be free to move in the X or Y directions, and will maintain zero 
displacement throughout the analysis. 
 
Nodes restrained in the X and Y directions are indicated by a triangular "pin" symbol, when 
Restraints are displayed, as configured in the Display Options dialog. 
 
See the Applying Restraints topic for information about applying restraints. 
 
Tips 
By default, the entire EXTERNAL boundary is given a "pinned" boundary condition when 
the mesh is generated. It is not necessary for the user to use the Restrain XY option on the 
EXTERNAL boundary, unless they wish to change previously applied Fixed X, Fixed Y or 
Free boundary conditions. 
 
Free 

The Free (or Delete Restraints) option is used to free any nodes which are restrained in 
the X, Y or X and Y directions. For example, if you are modeling a surface excavation, in 
most cases you will want to apply a Free boundary condition to all segments of the 
EXTERNAL boundary representing the ground surface. 
 
No symbol appears at nodes which are free, since they are completely free to move with no 
restraints. 
 
See the Applying Restraints topic for information about applying restraints. 
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Add Displacement 
The Add Displacement option allows you to specify a non-zero, fixed displacement as a 
boundary condition. To use this option: 
 

1. Select Add Displacement from the Displacements sub-menu of the Restraints 
menu. 

2. You will see a dialog allowing you to enter X and / or Y displacements. If you only wish 
to specify a displacement in the X or Y direction, then de-select the appropriate 
checkbox. Enter the displacement(s) and select OK. 
Note: if you de-select the X or Y displacement checkbox, then the node(s) will be free to 
move in the direction which you de-selected, and the displacement will only be fixed in 
one direction. 

3. The displacement boundary condition is then applied in the same manner as the 
Restrain X, Restrain Y, Restrain XY or Free options. See the Applying Restraints 
topic for information. An arrow symbol and the displacement magnitude(s) will indicate 
the presence of a displacement boundary condition. 

4. Note that the Apply Restraints option in the Restraint Options dialog also applies to the 
Add Displacement option, so the displacement boundary condition can be applied to 
boundary segments or individual nodes, as required. 

5. When you are finished, press Escape or right-click and select Done. 
 
To remove displacement boundary conditions applied with the Add Displacement option, 
you can use the Delete Displacements option or the Free option, as both have the same effect. 
 
Significance of a non-zero displacement boundary condition 
A non-zero displacement boundary condition means that the displacement you enter is fixed 
throughout the analysis. For example, if you entered 0 , -.5 in the dialog in Step 2 above, the 
displacement at the selected node(s) would be fixed at x = 0 , y = -.5 for the entire analysis. 
Experiment with this option to see how a non-zero displacement boundary condition affects a 
model. 
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Delete Displacement 
You can use Delete Displacement to delete displacement boundary conditions added with 
the Add Displacement option. 
 

1. Select Delete Displacement from the Displacements sub-menu of the Restraints 
menu. 

2. Select the displacement boundary conditions to delete (you can select multiple nodes 
with a selection window). 

3. When finished, press Escape or right-click and select Done. 
 
Tips 
You can also use the Free option for this purpose, it has the same effect as Delete 
Displacement. 
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Bolts Overview 
Adding Bolts 
Bolts are added to a model using either the Add Pattern Bolts option or the Add Spot Bolts 
option. They can also be added from a DXF file . Note:  
 

• Bolts can only be added to a PHASE2 model, after the mesh has been generated. 
• Bolts can be added to EXCAVATION, STAGE or EXTERNAL boundaries (they 
cannot be added on MATERIAL or JOINT boundaries). 
 
Bolt Properties 
Four bolt models are currently available in PHASE2: 

• End Anchored 
• Fully Bonded 
• Plain Strand Cable 
• Split Set / Swellex 

Bolt properties are defined with the Define Bolts option, and then assigned to the bolts with 
the Assign Properties option. 
 
Bolts & Staging 
When adding bolts (Add Pattern Bolts or Add Spot Bolts ) to a multi-stage model, it is useful 
to remember that they are automatically installed at the stage on which you are adding 
them. 
 

• For example, if you had a three stage model, and you added bolts at stage two (ie. the 
Stage 2 tab was selected at the bottom of the view), they would automatically be 
UNINSTALLED at stage 1, and INSTALLED at stages 2 and 3. 

 
If the bolts are not initially installed at the desired stage, the staging can be changed at any 
later time using the Assign option. A complete discussion of assigning bolt properties and 
staging is found in the Assign Bolts topic. 
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Add Pattern Bolts 
The Add Pattern Bolts option allows the user to quickly add a uniformly spaced pattern of 
bolts to a boundary. To add a pattern of bolts to a model: 
 

1. Select Add Pattern Bolts from the toolbar or the Support menu.  
2. You will see the Pattern Bolts dialog, in which you may enter: 

• Bolt Length and In-Plane Spacing 
• Select the type of boundary you want to apply the pattern to (Excavation, Stage or 

External) 
• Select the Pattern Type (Normal to Boundary or Radial) 

3. Select OK and follow the instructions in the prompt line, for Normal Pattern Bolting or 
Radial Pattern Bolting, as described below. 

 
Normal Pattern Bolting 
If your Pattern Type was Normal to Boundary, you will be prompted: 
 
     Select boundary vertex to start bolt pattern [enter=done, esc=quit]: 
     Select boundary vertex to end bolt pattern [enter=done, esc=quit]: 
 
Use the mouse to select two vertices on the same boundary (excavation, stage or external), 
and the pattern will be generated between the two points after the second point is entered. 
 
NOTE: 

• Only boundary vertices can be selected as the start / end points of a bolt pattern. 
Boundary vertices are the points which define the geometry of your boundaries. You 
cannot select mesh nodes on a boundary for this purpose, unless a node is coincident 
with a boundary vertex.  

• Be careful to note the counter-clockwise entry convention for the starting and ending 
vertices on EXCAVATION or EXTERNAL boundaries. If you make a mistake with the 
counter-clockwise convention, use the Undo option to undo the incorrect pattern, and 
then re-install the pattern, but reverse the order of the two vertices which you 
previously entered.  

• Similarly, on a STAGE boundary, if the pattern bolts appear on the wrong side of the 
boundary, then use the Undo option, and re-install the pattern with the order of the 
two vertices reversed. 
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Radial Pattern Bolting 
If your Pattern Type was Radial, you must first respond to the prompt: 
 
     Select drilling point [enter=done, esc=quit]: 
 
Use the mouse to select a point within an excavation from which the Radial bolt pattern is to 
be drilled. You can also use the keyboard to enter an x-y location in the prompt line. 
 
After the drilling point is established, the procedure is the same as described for the Normal 
bolt installation (ie. you must pick starting and ending vertices on the boundary). 
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Add Spot Bolt 
The Add Spot Bolt option allows the user to add individual bolts to a model. 
 
To add spot bolts: 
 

1. Select Add Spot Bolt from the toolbar or the Support menu. 
2. You will be prompted to enter two points for each bolt: 

Enter vertex[esc=quit]: 
Enter vertex[u=undo, esc=quit]: 

Use the mouse to enter the points, or you can enter x-y coordinates in the prompt line. 
3. Each spot bolt is added to the model as soon as the second point is entered.  
4. You can enter as many spot bolts as you wish, by continuing to enter points. 
5. When you are finished, press Escape or right-click and select Done. 

 
Spot bolts are automatically intersected with EXCAVATION, EXTERNAL and STAGE 
boundaries. To ensure that the bolt actually intersects the intended boundary, you should 
make sure that the point on the boundary is either exactly ON the boundary, or extends 
slightly past it. If it extends past the boundary, then it will be automatically and correctly 
intersected with the boundary. 
 
Adding Bolts with Faceplates 
The following bolt models in PHASE2 allow the user to attach face plates to one end of the 
bolt: 

Plain Strand Cable 
Split Set / Swellex 

The face plate option is one of the bolt properties in the Define Bolt Properties dialog. It is 
important to note the following: 

• When adding bolts with faceplates, PHASE2 will automatically locate the face plate on 
the end of the bolt which intersects a boundary. Bolt face plates are indicated by small 
circular markers displayed at one end of a bolt. 

• However, when bolts are installed between two excavations, PHASE2 cannot 
automatically determine which end of the bolt requires the face plate. In this case, the 
following rule is in effect – the FIRST point of each bolt, must be the end with the face 
plate. If you make a mistake with this convention, then use the Undo option (or delete 
the bolt). Then re-enter the bolt, but reverse the order of the two points defining the 
bolt. 

 



 

 121

Delete Bolts 
To delete bolts: 
 

1. Select Delete Bolts from the toolbar or the Support menu. 
2. Select the bolts to delete. You can select individual bolts by clicking on them with the 

left mouse button, or multiple bolts by enclosing them in a selection window.  
3. When you are finished selecting, press Enter or right-click and select Done Selection, 

and all selected bolts will be deleted. 
 
Tips 

• If you accidentally select bolts that you don’t want to delete, they can be un-selected by 
simply re-selecting them with the left mouse button. 

• If you are deleting bolts from a staged model, you can select the bolts at any stage, even 
if they are not installed at that stage. Bolts are still visible when not installed, but are 
displayed in a lighter colour. 
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Stretch Bolts 
You can use the Stretch Bolts option to modify existing bolts, to make them longer, shorter 
or change their position. To stretch bolts: 
 

1. Select Stretch Bolts from the Support menu. 
2. You will be prompted to pick the bolt vertices that you wish to stretch. You can select 

them individually, or select multiple bolt vertices with a selection window. 
3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. You will then be prompted to enter a base point and a second point defining the stretch. 
5. As soon as you enter the second point, the selected bolt vertices will be moved to their 

new positions. 
 
Tips 

• Depending on the situation, it may be easier to delete bolts and re-enter new ones, than 
use the Stretch Bolts option. For example, if you wanted to change the length of 
pattern bolts around an excavation, it would generally be easier to delete the existing 
pattern and enter a new one with the desired bolt length. 

• To define a "relative" stretch, enter 0 , 0 as the base point in the prompt line, and the 
relative x , y stretch at the second point, at step 4) above. This is an easy way of 
stretching by a known amount. 
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Bolt DXF Import 
Bolts can be imported into a PHASE2 model from a DXF file using the Import DXF option in 
the File menu. The mesh must exist before bolts can be imported. See the Import DXF topic 
for details. 
 
Bolts can also be exported to a DXF file using the Export DXF option. 
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Liner Overview 
Liners in PHASE2 allow the user to model reinforcement which is applied in the form of a 
liner to excavation boundaries. Liners are typically used to model shotcrete. However, liners 
can also be used to model concrete or steel linings, for example. Composite Liners can be 
defined, which represent liners consisting of multiple layers of material. 
 
Adding Liners 
Liners are added to a model using the Add Liner option. Note: 

• Liners can only be added to a PHASE2 model, after the mesh has been generated. 
• Liners can be added to any type of boundary in PHASE2, with the exception of JOINT 

boundaries (ie. liners can be added to EXCAVATION, STAGE, MATERIAL or 
EXTERNAL boundaries). 

 
Liner Properties 
Liner properties are defined with the Define Liners option, and then assigned to the liners 
with the Assign Properties option. 
 
In the most general case, Composite Liners can be defined using the Define Composite 
option. A Composite Liner can represent up to 4 different layers of material. The properties 
of each individual layer of a Composite Liner, are defined using the Define Liners option. 
The effect of slip between the excavation boundary and the first liner layer, may be 
accounted for. Composite Liner properties are assigned in the same manner as regular 
liners, using the Assign Properties option. See the Define Composite topic for complete 
details. 
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Add Liner 
To add liners to a model: 
 

1. Select Add Liner from the toolbar or the Support menu. 
2. Select the boundary line segments that you wish to line. Liners can be added to 

EXCAVATION, STAGE, MATERIAL or EXTERNAL boundary line segments. (They 
may NOT be applied to JOINT boundaries). 

NOTE: To select multiple adjoining line segments to be lined (for example, the curved 
roof of an excavation), a selection window is useful. All line segments within or crossing 
the selection window will be selected. This is important because if segments are selected 
individually, some may be missed. 

3. When you are finished selecting, press Enter or right-click and select Done Selection. 
4. All selected segments will display thick blue line segments along each finite element 

edge. Each of these blue line segments represents a "beam" element on the boundary. 
 
Liners & Staging 
When adding liners to a multi-stage model, it is useful to remember that a liner is 
automatically installed at the stage in which you are adding it. 
 

• For example, if you had a three stage model, and you added a liner at stage two (ie. the 
Stage 2 tab was selected at the bottom of the view), the liner would automatically be 
UNINSTALLED at stage 1, and INSTALLED at stages 2 and 3. 

 
If the liners are not initially installed at the desired stage, the staging can be changed at any 
later time using the Assign option. A complete discussion of assigning liner properties and 
staging is found in the Assign Liners topic. 
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Delete Liner 
To delete liners: 
 

1. Select Delete Liner from the toolbar or the Support menu. 
2. Select the boundary line segments from which to delete liners. 
3. When you are finished selecting, press Enter or right-click and select Done Selection, 

and all selected line segments will have the liners removed. 
 
Tips 
If you are deleting liners from a staged model, you can select the boundary line segments at 
any stage, even if the liner is not installed at that stage. Liners are still visible when not 
installed, but are displayed in a lighter colour. 
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Properties Overview 
The final step in creating a PHASE2 model is to: 
 

• DEFINE all of the required material properties, and then 
• ASSIGN these properties to the various elements of your model. 

 
Properties are defined using the Define options in the toolbar or the Properties menu (ie. 
Define Materials, Define Bolts etc.) Properties can also be imported from other PHASE2 files, 
using the Import Properties option in the Import sub-menu of the File menu. 
 
Properties are assigned with the Assign Properties option in the toolbar or the Properties 
menu. The Assign option is also used to assign the staging sequence of excavations and 
support installation. 
 
Default Properties 
The first tab of each Define dialog (ie. Define Materials , Define Bolts , Define Liners , 
Define Joints ) represents the DEFAULT property assignment for that option. The 
significance of the DEFAULT property assignment is as follows: 
 

• All entities of your model (eg. finite elements, bolts, liners, joints) are initially assigned 
the DEFAULT properties when the entities are created or added to the model. The 
default properties are in effect until you use the Assign options to assign other 
properties. 

 
One advantage of having a DEFAULT assignment, is that if you are only working with one 
type of a given entity (ie. your model only contains one material, or one bolt type, or one liner 
type, etc), then you can Define your properties using the first tab in the Define dialogs, 
without having to Assign them, since the default properties are automatically in effect. 
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Define Materials 
To define your material (eg. rock or soil) properties, select Define Materials from the 
toolbar or the Properties menu.  
 
You can define up to 40 different material types in the Define Material Properties dialog. See 
the following topics for details. 
 
Name  
Material Colour  
Initial Element Loading  
Unit Weight  
Elastic Properties  
Strength Properties  
Staged Material Properties  
 
NOTE: Properties can also be imported from other PHASE2 files, using the Import 
Properties option in the Import sub-menu of the File menu. 
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Material Name 
The Material Name you enter in the Define Material Properties dialog will appear in the 
Assign dialog when you are assigning the material properties. Therefore use a meaningful 
name which you can associate with your rock type (eg. "sandstone" instead of "rock1"). It will 
also appear in the tabs at the top of the Define Material Properties dialog. 
 
 

Material Colour 
The Material Colour you choose in the Define Material Properties dialog will appear in the 
Assign dialog, beside the Material Name .  
 

• The user can customize any material colour.  
• To restore the original colour used by PHASE2, select Material Colour and select 

Default. 
 



 

 130 

Initial Element Loading 
In the Define Material Properties dialog, Initial Element Loading allows the user to specify 
whether Field Stress and / or Body Force will be used for the initial element loading of a 
given material type. Four options are available: 
 

• Field Stress Only 

• Field Stress & Body Force 

• Body Force Only 

• None 

 
Field Stress loading is derived from the values entered in the Field Stress dialog. 
 
Body Force loading represents the self-weight of the elements, and is derived from the Unit 
Weight of the material entered in the Define Material Properties dialog.  
 
If you are using a CONSTANT field stress, then the default Initial Element Loading for each 
material, will be Field Stress Only. 
 
If you are using a GRAVITY field stress, then the default Initial Element Loading for each 
material, will be Field Stress & Body Force. 
 
Tips 
Users often are confused by the concept of Initial Element Loading, and how it relates to the 
Field Stress defined in the Loading menu. Here are some further comments: 
 
The initial element loading is one of the most difficult concepts to grasp in Finite-Element 
(FE) modeling. Basically, in FE an element can have two initial internal loadings, initial   
stress and body force. Body force is just self weight. If you use just body force in a model then 
you will notice that a component of the displacements is due to your model settling under it's 
own weight. If you use materials with initial element loading set to body force only then the 
Field Stress defined in the Loading menu is NOT used   at all. This brings us to the case of 
initial stress. An initial stress locks in a particular stress in an element. The stress that is 
locked into the element is defined in the Field Stress dialog. Think of a finite element as a 
sponge, applying an initial stress is like compressing the sponge. If you release confinement 
on an edge of the sponge it will expand in that direction. This is basically what happens 
when you open up an excavation in a material with an initial stress. Now how do body force 
and initial stress relate. They work to balance each other out. Think of an element with 
initial stress, then put a layer of material on top of it such that the material has enough body 
force to balance the initial stress. As a result the element is in equilibrium and won't expand 
or contract. As an example, let's think of a bucket (a rectangular region) of material 
represented by finite elements. The boundary conditions are free on the top surface and 
rollers on the left/right/bottom sides. If the material has just body force then it settles under 
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it's own weight and the top surface moves down. If the material has just initial stress then it 
expands and the top surface moves up. If you have both defined then the material is in 
equilibrium and there is no displacement of the top surface. To have the body force and field 
stress balanced you must use a gravitational Field Stress with unit weight equal to the 
materials unit weight and a ground surface elevation equal to the top of the bucket. 
 
Unit Weight 
The Unit Weight in the Define Material Properties dialog works in conjunction with the 
Initial Element Loading , and is not applicable unless Body Force is included in the Initial 
Element Loading. That is, Unit Weight is only enabled if Initial Element Loading is either: 
 

• Field Stress & Body Force or 
• Body Force Only 

 
Unit Weight is disabled if Initial Element Loading = either Field Stress or None 
 
If applicable, the Unit Weight is used to determine the Body Force applied to each finite 
element. 
 
Unit Weight vs. Unit Weight of Overburden (Gravity Field Stress) 
If you are using GRAVITY field stress, you should understand the distinction between the 
Unit Weight of a material entered in the Define Material Properties dialog, and the Unit 
Weight of Overburden entered in the Field Stress dialog. 

• The Unit Weight of a material in the Define Material Properties dialog, is used to 
determine the Body Force applied to each finite element of a given material type.  

• The Unit Weight of Overburden in the Field Stress dialog, is used to determine the 
Gravity Field Stress for all finite elements in the model. 

• For a multiple material model, these two unit weights will not necessarily be the same. 
• For a single material model, then the Unit Weight in the Define Material Properties 

dialog should be the same as the Unit Weight of Overburden in the Field Stress dialog.  
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Elastic Properties 
Three elastic models are available for defining your rock elastic properties, in the Define 
Material Properties dialog: 
 

• ISOTROPIC 
• TRANSVERSELY ISOTROPIC 
• ORTHOTROPIC 

 
Note that if a given material is defined as PLASTIC (in Strength Parameters ), then you 
must use ISOTROPIC elastic properties for that material. In PHASE2, you cannot combine 
plasticity with TRANSVERSELY ISOTROPIC or ORTHOTROPIC elastic properties. 
 
Isotropic 
An ISOTROPIC material only requires Young’s Modulus and Poisson’s Ratio. 
 
Transversely Isotropic 
A TRANSVERSELY ISOTROPIC material requires the following parameters: 

• E1 and E2 are the in-plane elastic moduli. (Ez is the out-of-plane elastic modulus, and 
is equal to E1) 

• The required Poisson’s ratios are ν12 and ν1z = νz1 = ν. Note that νij implies strain in 
the j-direction due to strain in the i-direction. Also note that Ei / Ej = νij / νji. Therefore, 
the plane 1-Z is the isotropic plane 

• G12 is the in-plane shear modulus 
• The ANGLE is measured between the x-direction and the direction of E1, as shown in 

the figure below. 

 
Definition of ANGLE for TRANSVERSELY ISOTROPIC or ORTHOTROPIC materials 

 
Orthotropic 
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The required elastic parameters are now E1, E2 and Ez, where the out-of-plane elastic 
modulus Ez is no longer equal to E1. Three separate Poisson’s ratios are required, ν12, ν1z 
and ν2z. The in-plane shear modulus G12 and the ANGLE are the same as for a 
TRANSVERSELY ISOTROPIC material. 
 
Strength Parameters 
In the Define Material Properties dialog, three failure criteria are available in PHASE2 for 
defining the strength of your rockmass: 
 

• MOHR-COULOMB 
• HOEK-BROWN 
• DRUCKER-PRAGER 

 
Remember that the strength parameters you enter should reflect the strength of the rockmass, 
and not necessarily the strength of an intact sample. 

 
Elastic Material 
The purpose of defining failure criterion parameters for an ELASTIC material, is to allow the 
calculation and plotting of strength factors. Even though an ELASTIC material in PHASE2 
does not "fail", the failure criterion allows a degree of overstress to be calculated. 
 
Plastic Material 
For PLASTIC materials, the strength parameters you enter will be used in the analysis if 
yielding occurs. This is unlike ELASTIC materials, where the strength parameters are only 
used to obtain values of strength factor, but do not affect the analysis results. 
 
If you define a material to be PLASTIC then you must define residual strength parameters 
and a dilation. 

• If the residual strength parameters are equal to the peak parameters, then you are 
defining an "ideally" elastic-plastic material. 

• The dilation is a measure of the increase in volume of the material when sheared. 
 
NOTE that if you define a given material as PLASTIC, then you are restricted to 
ISOTROPIC elastic properties for that material. You cannot combine plasticity with 
TRANSVERSELY ISOTROPIC or ORTHOTROPIC elastic properties. 
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Staged Material Properties 
In PHASE2, the properties of a material can be modified at different stages of a multi-stage 
model, by using the Stage Material Properties option in the Define Material Properties 
dialog. This allows the user to simulate, for example: 
 

• an increase or decrease in material stiffness 
• an increase or decrease in material strength 

 
as staging progresses. Any of the material parameters entered in the Define Material 
Properties dialog, can be increased or decreased by user-defined factors at different stages, as 
described below. To stage material properties: 
 

1. In the Define Material Properties dialog, select the Apply Factors checkbox in the Stage 
Material Properties area at the bottom of the dialog. 

2. The Define Factors button will now be enabled. Select this button, and the Stage 
Material Properties dialog will appear. 

3. In the Stage Material Properties dialog, select the Add Stage button, until the number 
of rows in the dialog, is equal to the number of stages at which you need to modify the 
material properties. For example: 
1. if you need to modify material properties at 3 different stages, then select Add Stage 

TWICE, so that a total of 3 rows appears in the dialog. 
4. In each row, enter the Stage number at which the properties are to be modified. 
5. In each row, enter the required Factor(s) which will be used to modify the indicated 

material parameter(s). NOTE: 
• the Factors are multiplied by the parameter values in the Define Material Properties 

dialog, in order to obtain the actual value to be used for a parameter, at a given 
stage of the analysis 

• for example, if you want to increase Young’s Modulus by 20%, enter a Factor of 1.2 
for Young’s Modulus, at the desired stage(s) 

• leave the Factor = 1 for any parameter which does not change value 
6. It is important to note that you only need to define the stage and factor information, for 

the stages at which you want to modify properties. You DO NOT need to define this 
information at stages where the properties do not change.  

7. If you accidentally add too many rows with the Add Stage button, click the mouse in a 
row and select the Delete Stage button, to delete the row. 

8. When you are finished entering all stage numbers and factors, select OK in the Stage 
Material Properties dialog. Select OK in the Define Material Properties dialog when you 
are finished defining all materials. 
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When the analysis is run, PHASE2 will use the factors in the Stage Material Properties 
dialog, to determine the material properties to be used at each stage of the analysis, for a 
given material. 
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Define Groundwater Properties 
The Define Groundwater Properties option, in the toolbar or the Properties menu, is 
used to specify the groundwater information for each material in the Define Material 
Properties dialog. This is applicable only if your PHASE2 model incorporates groundwater 
(ie. you have defined Piezometric Lines or a Water Pressure Grid, in order to include pore 
pressure in the analysis). NOTE: 
 

• The material names and colours which appear in the Define Groundwater 
Properties dialog, are those which are specified in the Define Material Properties 
dialog. 

• The options available in the Define Groundwater Properties dialog, correspond to 
the Groundwater Method specified in the Project Settings dialog: 
• If the Groundwater Method = Piezometric Lines, then you will be able to assign 

Piezometric Lines to each material. 
• If the Groundwater Method = Water Pressure Grid, then you will simply be able to 

turn the effect of the grid on or off, for each material. 
 
Piezo to Use 
Piezometric Lines are created with the with the Add Piezometric Line option. Each 
Piezometric Line has an ID number associated with it. These ID numbers are automatically 
created by PHASE2, when the Piezometric Line is added to the model. 
 
The Piezo to Use option in the Define Groundwater Properties dialog, will contain a list of ID 
numbers of all Piezometric Lines which currently exist in the model.  

• By default, the Piezo to Use option is initially set to None. This means that NO 
Piezometric Line will be assigned to that material, and pore pressure at all points 
within such materials, will be zero. 

• In order to assign a Piezometric Line to a given material, simply select the ID number 
of the desired Piezometric Line, from the Piezo to Use drop-down list. The selected 
Piezometric Line will then be used for the pore pressure calculations for that material. 

 

NOTE: the Piezo to Use option is applicable if you want to use ONE Piezometric Line for the 
pore pressure calculation for a given material, AT ALL STAGES OF THE MODEL (for 
staged models). If you require different piezo lines to be applied at different stages, for a 
given material, then use the Stage Piezo Lines option described below. 

 
Stage Piezo Lines 
If your model consists of multiple stages, and you require different piezo lines to be applied 
at different stages, for a given material, then use the Stage Piezo Lines option. This allows 
you to simulate, for example, the draw down of a water table at different stages. 
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To assign the staging of Piezometric Lines: 
 

1. In the Define Groundwater Properties dialog, select the Stage Piezo Lines checkbox. 
2. You will notice that the Piezo to Use option becomes disabled, and the area below the 

Stage Piezo Lines checkbox becomes enabled.  
3. Now select the Add Stage button, until the number of rows is equal to the number of 

stages at which you need to specify a Piezometric Line. For example: 
• if you need to assign 3 Piezometric Lines at 3 different stages, then select Add Stage 

TWICE, so that a total of 3 rows appears in the data entry area below the Stage 
Piezo Lines checkbox. 

NOTE: if the Add Stage button is disabled, this means that you have not set the 
Number of Stages in Project Settings. In this case, go to the Project Settings dialog, 
and enter the correct Number of Stages (greater than 1) for the model. 

4. In each row, enter the Stage number at which the Piezometric Lines are to be assigned. 
5. In each row, select the Piezo ID number representing the Piezometric Line that you 

wish to assign at the specified stage. 
6. It is important to note that you only need to define the Stage and Piezo ID information, 

for the stages at which the Piezometric Line will change. You DO NOT need to define 
this information at stages where the Piezometric Line does not change.  

7. If you accidentally add too many rows with the Add Stage button, click the mouse in a 
row and select the Delete Stage button, to delete the row. 

8. When you are finished entering the Stage and Piezo ID numbers, if your model consists 
of multiple materials with the same staging of Piezo Lines, you can use the Copy to All 
button, to automatically copy the Stage / Piezo ID information, to all materials in the 
dialog (see below).  

9. When the analysis is run, PHASE2 will use the Stage and Piezo ID information in the 
Define Groundwater Properties dialog, to determine the correct Piezometric Line to be 
used at each stage of the analysis, for each material. 

 
Copy To All 
The Copy To All option allows you to define the groundwater information for one material, 
and then automatically copy the same information, to all materials in the dialog. This is 
useful when all or most of the materials in a model, have the same groundwater conditions 
(for example, they all use the same water table).  
 
The Copy to All option is particularly useful, if you are using the Stage Piezo Lines option, 
and your model has multiple materials and piezo lines. The staging information can then be 
defined only once, and automatically copied to all materials. For example: 
 

• Define your Piezometric Line staging information for ONE material.  
• Select Copy to All, and the same information will be automatically entered for ALL 

materials in your model. 
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• NOTE that the Copy to All option also copies the value of the Hu coefficient for the 
current material, to all materials. 

 
Of course, this assumes that you wish to define the same groundwater conditions, for all 
materials in your model. If the same information applies to MOST but not all of your 
materials, then you can still use the Copy to All option, and then individually edit any 
materials which require different information. 
 
Hu Value 
The Hu Value is simply a factor by which the vertical distance from a point in the model, to a 
Piezometric Line is multiplied to obtain the pressure head. The Hu Value may range between 
0 and 1. Hu = 1 would indicate hydrostatic conditions. Hu = 0 would indicate a dry material, 
and intermediate values are used to simulate head loss due to seepage. See the Pore 
Pressure Calculation Using Piezometric Lines topic for details.  
 
Use Grid Values 
If the Groundwater Method in Project Settings is set to one of the 3 water pressure grid 
options – Grid (Total Head), Grid (Pressure Head) or Grid (Pore Pressure), then the Use Grid 
Values option will be enabled in the Define Groundwater Properties dialog. 
 
The Use Grid Values option simply allows the user to toggle the effect of a Water Pressure 
Grid, ON or OFF for a given material.  

• If the Use Grid Values checkbox is selected, then pore pressure will be calculated from 
the Water Pressure Grid. 

• If the Use Grid Values checkbox is NOT selected, then pore pressure for that material 
will be set to ZERO throughout the analysis, and the Water Pressure Grid will have no 
effect, for that material. 

 
NOTE that currently in PHASE2 it is NOT possible to stage Water Pressure Grids, in the 
same manner as Piezometric Lines. Only ONE Water Pressure Grid may be defined for a 
model, and used at all stages. This may be improved in a future PHASE2 upgrade, to allow 
multiple water pressure grids to be read into a model, and applied at different stages. 
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Pore Pressure Calculation 
Piezometric Lines are used for pore pressure calculation if the Groundwater Method in 
Project Settings is set to Piezometric Lines. 
 
Pore pressure is calculated for a Piezometric Line using: 
 

• the Pore Fluid Unit Weight (entered in the Project Settings dialog) 
• the vertical distance from a point to a Piezometric Line and  
• the Hu Value for the material (entered in the Define Groundwater Properties dialog), as 

follows: 
 

Pore Pressure = Pore Fluid Unit Weight * Vertical Distance to Piezometric Line * Hu 
Value 

 
If the distance is negative, (ie. Piezometric Line is below a given point) then the pore 
pressure is set to zero at that point. 
 
What is the Hu Value? 
The Hu Value, as defined in PHASE2, is simply a factor between 0 and 1, by which the 
vertical distance from a point in a material to a Piezometric Line is multiplied to obtain the 
pressure head. An Hu Value can be defined for each material in the Define Groundwater 
Properties dialog. Hu = 1 would indicate hydrostatic conditions. Hu = 0 would indicate a 
dry material, and intermediate values are used to simulate head loss due to seepage. 
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Define Bolts 
To define your bolt properties, select Define Bolts from the toolbar or the Properties 
menu.  
 
You can define up to 20 different bolt types in the Define Bolt Properties dialog.  
 
There are currently four different bolt models available in PHASE2: 
 
End Anchored  
Fully Bonded  
Plain Strand Cable  
Split Sets / Swellex  
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End Anchored Bolts 
The End Anchored bolt model in PHASE2 works as follows: 
 

• Each bolt behaves as a single element. Interaction with the finite element mesh is 
through the endpoints of the bolt only. 

 
Failure Mechanism 

• An End Anchored bolt fails in tension, when the peak capacity is exceeded.  
• An End Anchored bolt has no residual capacity after failure, the entire bolt is 

considered to have failed. 
 
Fully Bonded Bolts 
The Fully Bonded bolt model in PHASE2 works as follows: 
 

• Fully Bonded bolts are divided into "bolt elements" according to where the bolts cross 
the finite elements. These bolt elements act independently of each other – neighbouring 
Fully Bonded bolt elements do not influence each other directly, but only indirectly 
through their effect on the rock mass. 

• The strength and stiffness of the rock/grout and bolt/grout interfaces are NOT 
accounted for – the bolt is assumed to remain fully bonded to the rock, and no interface 
effects are considered. 

 
Failure Mechanism 

• Failure of a Fully Bonded bolt element occurs in tension, when the axial force on the 
bolt element exceeds the axial capacity. Failure of an element of a Fully Bonded bolt 
does not necessarily imply failure of adjacent elements on the same bolt. If you view 
yielded bolt elements in the PHASE2 INTERPRETER, you will see that Fully Bonded 
bolts can show yielding in some elements and not in others. 

• Unlike an End Anchored bolt, a Fully Bonded bolt element can still have a residual 
capacity (ie. it can still carry load) after the peak capacity is exceeded.  
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Plain Strand Cable 
The Plain Strand Cable model in PHASE2 works as follows: 
 

• The entire bolt behaves as a single element. Although for purposes of the algorithm, the 
bolt is discretized according to the intersections with the finite elements, the behaviour 
of each segment of the bolt has a direct effect on adjacent segments. 

• The stiffness of the grout, and the strength and stiffness of the bolt/grout interface is 
taken into account. 

• The effect of confining stress on the bolt due to excavation induced stress change is 
taken into account. 

 
Failure Mechanisms 

• At present, the only failure mechanism of a Plain Strand Cable bolt is by tensile 
rupture of the cable. 

• Failure of the cable/grout interface also occurs, but it is not a failure mechanism as 
such, since this interface is always assumed to be in a plastic state as the rock moves. 
The amount of relative slip at this interface, and the stiffness of the interface, 
determines how much shear force is generated at the cable. 

• Failure of the grout/rock interface is NOT currently considered, but may be in future. 
 
The following properties define a Plain Strand Cable bolt in PHASE2. 
 
Borehole Diameter 
The diameter of the borehole used to install the bolts. 
 
Cable Diameter 
The diameter of the cable. 
 
Cable Modulus 
The effective Young’s Modulus of the cable. 
 
Cable Peak 
The peak tensile capacity of the cable. 
 
Water-Cement Ratio 
The Water to Cement ratio of the grout used to install the cable. 
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Out-of-Plane Spacing 
The spacing between bolts in the out-of-plane direction (ie. normal to the analysis plane). 
 
Face Plates 
The Face Plates option allows the user to simulate the effect of face plates used on bolts.  

• If the Face Plates checkbox is selected, then the first vertex of each bolt will be "fixed" to 
the rock mass, allowing the bolt to develop load starting at the face plate. 

• If the Face Plates checkbox is NOT selected, then the load at the beginning of the bolt 
will be zero. 

 
Add Pull Out Force 
The Add Pull Out Force option allows the user to simulate the effect of a pull-out test on a 
bolt, by applying a tensile force to the beginning of the bolt. To use this option, select the Add 
Pull Out Force checkbox, and enter the desired value of pull out force. The force will be 
applied as a tensile load to the first vertex of the bolt. 
 
Constant Shear Stiffness 
In the Plain Strand Cable model in PHASE2, the shear stress vs. shear displacement graph 
for a bolt, will in general be non-linear. Therefore the shear stiffness will be variable, and 
will change according to the shear stress. The user may impose a Constant Shear Stiffness, 
by selecting the Constant Shear Stiffness checkbox, and entering a value. The shear stiffness 
will then be independent of the shear stress on the bolt. Note that the units of Shear 
Stiffness are FORCE / LENGTH / LENGTH. 
 
References 
For information about the development of the Plain Strand Cable model, see the following 
references. 
 
Moosavi, M. (1997), "Load distribution along fully grouted cable bolts based on constitutive 
models obtained from modified Hoek cells". Ph.D. Thesis, Queen's University, Kingston, 
Ontario, Canada. 
 
Moosavi, M. , Bawden, W.F. and Hyett, A.J., (1996), "A comprehensive laboratory test 
programme to study the behaviour of modified geometry cable bolt support", Rock mechanics, 
tools and technics, Proceedings of the 2nd North American Rock Mechanics Symposium, 
Montreal. 
 
Hyett, A.J., Moosavi, M and Bawden, W.F., (1996), "Load distribution along fully grouted 
bolts, with emphasis on cable reinforcement",  Int. J. of Num. & Anal. Meth. in Geomech. Vol 
20, pp 517-544. 
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Hyett, A.J, Bawden, W.F., MacSporran, G.R., and Moosavi M., (1995), "A constitutive law for 
bond failure of fully grouted cable bolts using a modified Hoek cell", Intl. J. Rock Mech. and 
Mining Sci. & Geomechanics Abstracts, Vol 32, No.1, pp 11-36. 
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Swellex / Split Sets 
The Swellex / Split Set bolt model (also called Frictional bolts or Shear bolts) in PHASE2 
works as follows:  
 

• The entire bolt behaves as a single element. For purposes of the algorithm, the bolt is 
discretized according to the intersections with the finite elements, however, the 
behaviour of each segment of the bolt has a direct effect on adjacent segments. 

• The stiffness of the bolt / rock interface is taken into account. 
• Unlike the Plain Strand Cable model, the confining stress level in the rock does NOT 

affect the shear strength or stiffness of the bolt. 
 
Failure Mechanisms 
A Swellex / Split Set bolt in PHASE2 can fail in two modes: 

• In tension, if the Tensile Capacity is exceeded. 
• In shear, if the Shear Capacity is exceeded. 

 
The following properties define a Swellex / Split Set bolt in PHASE2. 
 
Tensile Capacity 
This is the maximum tensile (axial) force which the bolt is capable of sustaining.  
NOTE: 

• The Tensile Capacity option is only enabled, if the Bolt Model = Plastic (see below). If 
the Bolt Model = Elastic, then by definition the bolt behaves in an elastic manner only, 
and tensile (and shear) capacity (strength) is not considered, and is not applicable. 

• Tensile Capacity is equal to the (Yield Stress of the steel) * (Tributary Area) 
 
Tributary Area 
Swellex / Split Set bolts are hollow. The Tributary Area is the effective cross-sectional area 
of the bolt (ie. the cross-sectional area of the annulus of steel which makes up the bolt). It is 
NOT the total cross-sectional area of the bolt (ie. it does NOT include the hollow area of the 
bolt). The Tributary Area is used to calculate the axial stiffness of the bolt (see below). 
 
Bolt Modulus 
The Bolt Modulus is the Young’s Modulus of the bolt steel.  
NOTE: 

• The Bolt Modulus, Tributary Area and bolt length determine the axial stiffness of a 
bolt, ie.  Axial Stiffness = (Bolt Modulus) * (Tributary Area) / (bolt length) 
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Shear Capacity 
This is the maximum shear force capacity of the bolt / rock interface. The Shear Capacity is 
expressed as a FORCE per unit BOLT LENGTH. 
NOTE: 

• The Shear Capacity option is only enabled, if the Bolt Model = Plastic (see below). If the 
Bolt Model = Elastic, then by definition the bolt behaves in an elastic manner only, and 
shear (and tensile) capacity (strength) is not considered, and is not applicable. 

• Shear Capacity can be determined from empirical methods such as pull-out tests. 
 
Shear Stiffness 
This is the shear stiffness of the bolt / rock interface. Note that the units of Shear Stiffness 
are FORCE / LENGTH / LENGTH. The Shear Stiffness can be thought of as follows: 

• On a shear force vs. shear displacement graph, the Shear Stiffness is equal to the slope 
of the ELASTIC portion of the graph. Remember shear force is expressed as a FORCE / 
LENGTH therefore the units of the Shear Stiffness are FORCE / LENGTH / LENGTH. 

 
Out-of-Plane Spacing 
This is the spacing between bolts in the out-of-plane direction (ie. normal to the analysis 
plane). 
 
Bolt Model 

• If the Bolt Model = Elastic, then the tensile and shear capacity of the bolt is not 
considered. The Tensile Capacity and Shear Capacity options will be disabled. The bolt 
will behave in an elastic manner only, and the forces in the bolt will be determined by 
the Axial and Shear Stiffness. 

• If the Bolt Model = Plastic, then the tensile and shear capacity of the bolt is considered, 
and the Tensile Capacity and Shear Capacity options will be enabled. If the Tensile 
Capacity or Shear Capacity of the bolt is reached, then the bolt will behave in a 
perfectly plastic manner, and the axial or shear force in the bolt will not vary with 
further axial or shear displacement. 

 
Face Plates 
The Face Plates option allows the user to simulate the effect of face plates used on bolts.  

• If the Face Plates checkbox is selected, then the first vertex of each bolt will be "fixed" to 
the rock mass, allowing the bolt to develop load starting at the face plate. 

• If the Face Plates checkbox is NOT selected, then the load at the beginning of the bolt 
will be zero. 
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Add Pull Out Force 
The Add Pull Out Force option allows the user to simulate the effect of a pull-out test on a 
bolt, by applying a tensile force to the beginning of the bolt. To use this option, select the Add 
Pull Out Force checkbox, and enter the desired value of pull out force. The force will be 
applied as a tensile load to the first vertex of the bolt. 
 
Add Pre-Tensioning Force 
If the Add Pre-Tensioning Force checkbox is selected, this allows the user to include a pre-
tensioning force in the analysis. A pre-tensioning force is implemented as an initial axial 
force assigned to each bolt element of a bolt. (Bolt elements are determined by the 
intersections of the bolt with the finite element mesh). 
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Define Liners 
To define liner properties, select Define Liners from the toolbar or the Properties menu.  
 
You can define up to 20 different liner types in the Define Liner Properties dialog.  
 
Liners in PHASE2 allow the user to model reinforcement which is applied in the form of a 
liner to excavation boundaries. Liners are typically used to model shotcrete. However, liners 
can also be used to model concrete or steel linings, for example.  
 
NOTE: Composite Liners can be defined, which represent liners consisting of multiple layers 
of material. The properties of individual layers of Composite Liners, are defined with the 
Define Liners option. See the Define Composite Liners topic for details. 
 
Beam Formulation 
Liners are comprised of "beam" elements, corresponding to the edges of finite elements. Two 
different Beam Formulations are available in PHASE2 for modeling liners: 
 

• Timoshenko (allows for transverse shear deformation effects) 
• Bernoulli (the classical Euler-Bernoulli formulation, which takes no account of 

transverse shear deformation) 
 
The Timoshenko Beam Formulation is recommended if you are using finite elements with 
midside nodes (ie. 6-noded triangles or 8-noded quadrilaterals), since in this case PHASE2 
will automatically use 3-noded Timoshenko beam elements, resulting in displacement 
compatibility between the finite elements and the beam elements. Bernoulli beam elements 
are always 2-noded, and give less accurate results when used with 6-noded triangles or 8-
noded quadrilaterals. 
 
Liner Elastic Properties 
Liners are assumed to have isotropic elastic properties, therefore only a single Young’s 
modulus and a single Poisson’s ratio can be entered. 
 
Liner Strength Parameters 
If you define the liner Material Type to be ELASTIC, then strength parameters are not 
applicable, since there is currently no facility for visualizing a "strength factor" for elastic 
liners in PHASE2.  
 
If you define the liner Material Type to be PLASTIC, then you may enter peak and residual 
compressive and tensile strength parameters, which will be used in the PHASE2 analysis. 
Liners defined as PLASTIC will be able to yield, if the peak strength is reached. The 
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plasticity calculation uses the "layering" method presented in reference 1 (see below), in 
which the cross-section of the beam is partitioned into layers. If the stress in a given layer 
exceeds the peak strength (compressive or tensile), the layer yields.  
 
Stage Liner Properties 
In PHASE2, the properties of a liner can be modified at different stages of a multi-stage 
model, by using the Stage Liner Properties option in the Define Liner Properties dialog. This 
could be used, for example, to model the increase in strength and stiffness of shotcrete or 
concrete liners after initial placement. 
 
Any of the parameters entered in the Define Liner Properties dialog, can be increased or 
decreased by user-defined factors at different stages. For details about staging liner 
properties, see the Stage Material Properties topic, as the procedure for staging properties is 
the same. 
 
References 
Further information about the liner model used in PHASE2, can be found in the following 
references. 
 

1. D.R.J. OWEN and E. HINTON (1986), Finite elements in Plasticity theory and practice, 
Department of Civil Engineering, University College of Swansea, UK, Pineridge Press 
Limited, Swansea, UK. (Chapter 5.5) 

 
2. I.M. SMITH and D.V. GRIFFITHS, Programming the finite element method, Second 

ed., University of Manchester, UK, John Wiley and Sons, New York. (Chapter 4). 
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Define Joints 
To define joint properties, select Define Joints from the toolbar or the Properties menu.  
 
You can define up to 20 different joint types in the Define Joint Properties dialog.  
 
Normal & Shear Joint Stiffness 
Each joint element has a normal and a shear spring stiffness which relate the normal and 
shear stress on the element to the normal and shear displacement. The stiffness of the joint 
can be derived from the thickness and modulus of the infilling material (if these quantities 
are known) by the following equations: 
 

Kn = -Eo / h 
Ks = -Go / h 
 
Where: 
Kn = joint normal stiffness 
Ks = joint shear stiffness 
Eo = Young’s modulus of the infilling material 
Go = shear modulus of the infilling material 
h = joint thickness or aperture 

 
Slip Criterion 
If the Slip Criterion is None, then joints will behave elastically, according to the normal and 
shear joint stiffness, and cannot slip. 
 
If Slip Criterion is Mohr-Coulomb or Barton-Bandis, then local joint slip can occur if the 
shear stress on a joint element exceeds the shear strength as defined by the Slip Criterion 
parameters. 
 
Mohr-Coulomb Slip Criterion parameters are:  

• Cohesion 
• Friction Angle 
• Tensile Strength 

 
Barton-Bandis Slip Criterion parameters are: 

• JCS 
• JRC 
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• Residual Friction Angle 
 
Initial Joint Deformation 
Initial Joint Deformation refers to how the joint behaves in regard to the far field stresses. If 
the Initial Joint Deformation is ON, then the joint will deform based on both the far field 
stresses and the induced stresses due to any excavations. As a result, the stress field in the 
vicinity of the joint will be altered from the initial far field distribution. This will be evident 
if you run an analysis with a joint only (ie. no excavations). 
 
If Initial Joint Deformation is OFF, then a single joint, with no excavation, has no effect at 
all (try running this). With no Initial Joint Deformation, only the induced stresses from the 
presence of an excavation or an external load, can cause joint deformation. 
 
Stage Joint Properties 
The properties of a joint can be modified at different stages of a multi-stage model, by using 
the Stage Joint Properties option in the Define Joint Properties dialog. Any of the parameters 
entered in the Define Joint Properties dialog, can be increased or decreased by user-defined 
factors at different stages. For details about staging joint properties, see the Stage Material 
Properties topic, as the procedure for staging properties is the same. 
 
Allow slip starting from stage # 
The Allow slip starting from stage # option allows the user to specify that joint slip (ie. 
inelastic yield) cannot occur before a specified stage. To use this option, select the checkbox, 
and enter the stage at which the joint is allowed to slip. Note that elastic displacements may 
still occur before this stage. 
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Define Composite Liner 
A Composite Liner in PHASE2, is a liner which may consist of multiple layers of material. 
The different layers of a Composite Liner may have different material properties, and may be 
applied at different stages.  
 

• A Composite Liner may consist of up to 4 different layers. The properties of each layer 
of a Composite Liner, are defined using the Define Liner Properties dialog.  

• A joint may also be included in the Composite Liner, which will exist between the 
rockmass and the FIRST liner layer. The properties of the joint, are defined using the 
Define Joint Properties dialog. 

 
The Composite Liner Properties dialog allows the user to define a Composite Liner, by 
selecting individual liners (defined in the Define Liner Properties dialog), and a joint (defined 
in the Define Joint Properties dialog), in the desired sequence and combination. To define a 
Composite Liner: 
 
1. You must first define the properties of the individual layers of the Composite Liner, 
using the Define Liners option. 
2. If you are including a joint in the Composite Liner, then you must also define the 
properties of the joint, using the Define Joints option. 
3. Now select the Define Composite option from the toolbar or the Properties menu. 
4. In the Define Composite Properties dialog, select the Composite Type that you would 
like to define. 
• if you are NOT including a joint, then you can define a Composite Liner with 2, 3 or 4 
layers (ie. Composite Type = 2 liners, 3 liners or 4 liners) 
• if you wish to include a joint, then you can define a Composite Liner with 1, 2, 3 or 4 
layers (ie. Composite Type = 1 liner (with slip), 2 liners (with slip), 3 liners (with slip) or 4 
liners (with slip). 
5. Now use the drop-down lists, to select the desired sequence of liners which will be 
used, and also the joint, if included. 
NOTE: The liner (and joint) names which appear in the drop-down lists, are the liner (and 
joint) names, which you entered in the Define Liner Properties and Define Joint Properties 
dialogs, when you defined the liner (and joint) properties. Therefore it is important that you 
use meaningful names for the liners, so that you can easily identify the correct liners that 
you wish to use in the Define Composite Properties dialog. 
6. If your Composite Liner consists of 2, 3 or 4 liners, then you can now assign the stage 
of application of liners 2, 3 and 4, relative to the stage of application of the FIRST liner layer, 
using the drop-down list boxes at the right of the dialog. NOTE: 
• The stage of application of the FIRST liner layer, is determined with the Assign 
Properties option (see below). 
7. When you are finished defining the Composite Liner, select OK.  
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Composite Liners are assigned their initial stage application, in exactly the same manner as 
regular (single) liners, using the Assign Properties option. This determines the stage of 
application of the FIRST layer of the Composite Liner. The stage of application of all 
subsequent layers of the Composite Liner, is determined in the Define Composite Properties 
dialog, as described above. 
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Assign Properties Overview 
After you Define the material and support properties, you must Assign these properties to 
the various elements of your model. Default properties are initially in effect, but in general 
the user will have to make use of the Assign Properties option.  
 
When you select Assign Properties, you will see the Assign Properties dialog. At the 
bottom of this dialog is a drop-down list, which allows you to select which type of entity you 
wish to assign.  
 

• This list will always include Materials, which is the default selection.  
• All other entity types (ie. Bolts, Liners, Composite Liners, Joints) will only appear in 

the list, if these entities are currently part of your model.  
 
To assign properties or the staging sequence for a given type of entity, you must first select 
the desired entity from this list at the bottom of the Assign dialog. See the following topics 
for details: 
 
Assign Materials  
Assign Bolts  
Assign Liners  
Assign Joints  
Assign Composite  
 
NOTE: 

• The finite element mesh must exist before the Assign Properties option is enabled. 
• The Assign Properties dialog works a little differently than a regular dialog. It is 

known as a "roll-up" dialog, and can be left up on the screen while performing other 
tasks. The "arrow" button in the upper right corner can be used to "roll-up" or "roll-
down" the dialog, to minimize/maximize it without closing it. The X button will close the 
dialog. 
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Assign Materials 
The Assign Materials option is used to assign: 
 
• MATERIAL properties to the different material zone(s) of your model 
• The staging sequence of the EXCAVATIONS for STAGED models. 
 
To assign materials: 
 

1. In the Assign Properties dialog, make sure that Materials is selected in the drop-
down list at the bottom of the dialog.  

2. In the dialog, notice that the material names and colours are those which you defined in 
the Define Materials option. Use the mouse to select a material you would like to 
assign. 

3. Now as you move the cursor over the model, notice that a small cross-hair appears at 
the end of the cursor arrow. This indicates that you are in the mode to assign materials. 

4. Now simply locate the cross-hair cursor inside a material zone in your model, and click 
the left mouse button. You will see that all finite elements in the zone will change to the 
colour of the assigned material.  

5. Repeat step 4, to assign the same material to other zones of the model if necessary. You 
may need to zoom or pan the view, in order to accurately select regions to assign.  

6. If your model has multiple material types, repeat steps 2 to 5 to assign the desired 
materials to all the zones of the model.  

7. If you are finished with the Assign dialog, you can close it by selecting the X in the 
dialog, or by pressing Escape. 

 
NOTE that a material "zone" is any closed region defined by the intersection of any of the 
model boundaries (ie. EXCAVATION, EXTERNAL, MATERIAL, STAGE or JOINT 
boundaries). If a region is not "closed" you will discover this when you are assigning 
materials (the assignment will "leak" around the edges of any boundaries which do not 
intersect. If this occurs, you will have to reset the mesh, and edit the necessary boundaries, 
so that they intersect). 
 
To assign the staging of excavations: 
 

1. In the Assign Properties dialog, make sure that Materials is selected in the drop-
down list at the bottom of the dialog.  

2. Select the Excavate button at the bottom of the Assign dialog. 
3. Make sure the stage you are viewing is the stage at which you want to excavate. Use 

the Stage tabs to view the desired stage. 
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4. Click inside the region you want to excavate, and notice that the finite elements 
"disappear" in that region. This indicates that the region is excavated (see note below 
for more information). 

5. Repeat steps 3 and 4 to excavate your model in the desired sequence. 
 
NOTE: As of PHASE2 version 5, any closed region of the model, formed by the intersection of 
any of the model boundaries, can be excavated. In earlier versions of PHASE2, only the 
material within EXCAVATION boundaries could be excavated. This restriction has now been 
removed, and gives the user more freedom to define a model. For example, closed regions 
formed by the intersection of STAGE boundaries and the EXTERNAL boundary, can now be 
excavated. 
 
To assign backfill: 
You can backfill an excavated region at a later stage, by assigning another material to the 
region at any stage after the excavated stage – you will see that the finite elements reappear 
in the excavated region in this case. 
 
Tips 
• For a multi-stage model, material assignment and excavation applies to all stages 
AFTER and INCLUDING the stage at which the assignment was made. Stages BEFORE the 
assigned stage are NOT affected (ie. the material type will remain unchanged). Therefore, in 
most cases you should do all of your material assignments in the FIRST stage. 
• Any material assigned after the first stage, should, practically speaking, represent 
the backfill of an excavated region. However, since there is no restriction in PHASE2, you 
could actually change material properties from stage to stage.  
• The maximum number of times that a given region would normally be assigned 
properties is THREE – the initial material assignment, the EXCAVATED assignment, and a 
final material assignment, representing backfill. 
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Assign Bolts 
The Assign Bolts option is used to assign the bolt type(s) and installation sequence to the 
bolts in your model. 
 
To assign a bolt type: 
 

1. In the Assign Properties dialog, make sure that Bolts is selected in the drop-down list 
at the bottom of the dialog.  

2. In the dialog, notice that the bolt names and colours are those which you defined in 
the Define Bolts option. Use the mouse to select a bolt type you would like to assign. 
3. Use the mouse to select the desired bolts on the model (you can select multiple bolts 
with a selection window). When selected, bolts are highlighted by a dotted line. TIP – if you 
accidentally select bolts that you did not intend to select, they can be UNSELECTED, by 
clicking on them again with the left mouse button. 
4. When all desired bolts are selected, press Enter or right-click and select Done 
Selection. All selected bolts will be assigned the bolt type you chose, as indicated by their 
colour. 
5. If your model has multiple bolt types, repeat steps 2 to 4 to assign the correct bolt 
types to all the bolts in the model. 
6. If you are finished with the Assign dialog, you can close it by selecting the X in the 
dialog, or by pressing Escape. 
 
NOTE: 
• Bolts are initially assigned the properties of the first bolt type (ie. the first window in 
the Define Bolts dialog) when you added the bolts to the model. If you are only using one bolt 
type in your model, then you do not necessarily need to assign a bolt type (just make sure you 
define your bolt properties using the first tab of the Define Bolts dialog). 
• For a multi-stage model, the assigned bolt type applies to all stages – ie. the bolt type 
(of a given bolt) cannot change at different stages. 
 
To assign the staging of bolts: 
 
1. In the Assign Properties dialog, make sure that Bolts is selected in the drop-down 
list at the bottom of the dialog. 

2. Select the Install button at the bottom of the Assign dialog. 
3. Make sure the stage you are viewing is the stage at which you want to install the 
bolt(s). Use the Stage tabs to view the desired stage. 
4. Use the mouse to select the desired bolts (you can select multiple bolts with a 
selection window), and press Enter or right-click and select Done Selection when you are 
finished. All selected bolts will be:  
• INSTALLED at the stage you are viewing and all subsequent stages 
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• NOT INSTALLED prior to that stage.  
This applies regardless of any previous staging of the bolt(s) – ie. THE Install OPTION 
ALWAYS OVERRIDES ALL PREVIOUS STAGING INFORMATION. 
5. Repeat steps 3 and 4 as necessary for all of the bolts in your model. 
 
NOTE: 
• When bolts are added to a multi-stage model (using the Add Pattern or Add Spot 
options), they are automatically installed at the stage on which you are adding them. So if 
you plan ahead, you do not necessarily have to assign the bolt staging. Of course if you do not 
initially add them at the desired stage, you can always use the above procedure to install 
them at the correct stage. 
• Bolts which are NOT INSTALLED at a given stage are displayed in a lighter shade 
of the bolt type colour. This is illustrated in the figures below. 
 

       
 
Three stage model with staging of bolt installation. Note lighter colour of uninstalled bolts 

 
The Remove button in the Assign Bolts dialog, allows the user to "uninstall" a bolt AFTER it 
has been installed (for example, to simulate support loss due to corrosion of bolts). To Remove 
bolts after the installation stage: 
 
1. In the Assign Properties dialog select the Remove button. 
2. Make sure the stage you are viewing is the stage at which you want to uninstall the 
bolt(s). Use the Stage tabs to view the desired stage. 
3. Select the bolts to be "uninstalled", and press Enter or right-click and select Done 
Selection when you are finished. All selected bolts will be uninstalled from that stage 
forward, as indicated by the lighter shade of the bolt type colour. 
 
NOTE: 
• The most complicated staging any given bolt can receive is therefore 
UNINSTALLED, INSTALLED, and UNINSTALLED again, using the Install and Remove 
options as described above. 
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• After assigning bolt properties and staging, the correct staging of the bolts should 
always be verified by selecting the stage tabs, and observing the shading of the bolt colour – 
a light shade of the bolt colour indicates that a bolt is UNINSTALLED at a given stage. 
• If temporary support is installed within areas to be later excavated, it will be 
automatically mined out (ie. uninstalled) when the material is excavated. The user does not 
have to use the Remove option in this case – it is automatically taken care of. 
 
 

Assign Liners 
Liners are assigned properties and staged in exactly the same manner as bolts. See the 
Assign Bolts topic for information. 
 
NOTE that when you are selecting liners, you are actually selecting the boundary line 
segments (EXCAVATION, STAGE, MATERIAL or EXTERNAL) to which the liner has been 
applied. To make sure that you select all segments of a given liner, it is advisable to use a 
selection window, so that you do not accidentally miss portions of a liner when you are 
assigning properties and staging. 
 
 
Assign Joints 
Joints are assigned properties in the same manner as bolts or liners – see the Assign Bolts 
topic for information. 
 
Joints and Staging 
Joints cannot be staged in the way that bolts and liners can be staged, therefore there are no 
Install or Remove buttons in the Assign Properties dialog, when Joints is selected at the 
bottom of the dialog. However, note the following: 
 

• Segments of a joint which pass through an excavation, are automatically "removed" or 
"installed" when the area is excavated, according to whether the joint was defined as 
Natural or Artificial, when the joint was initially added to the model. See the Add Joint 
topic for details. 

• Also, in the Define Joints dialog, the user can specify that the joint is allowed to slip 
beginning at a given stage. This can be considered "staging" of the joint, however, this is 
done through the Define Joints dialog, and NOT the Assign Properties dialog. 
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Assign Composite Liners 
For the purposes of assigning properties and staging (of the initial liner layer), Composite 
Liners are equivalent to regular Liners, and the assignment procedure is exactly the same. 
 
See the Assign Liners and Assign Bolts topic for details. 
 
Staging of Composite Liner layers after the initial layer, is done through the Define 
Composite Properties dialog, and not with the Assign Properties dialog, which only 
establishes the installation stage of the FIRST layer of a Composite Liner. 
 
 
Reset Assign 

To reset property assignments, you can use the options in the Reset Assign sub-menu in the 
Properties menu. You can reset assignments for materials only, bolts only, joints only, 
liners only, or ALL entities of your model. 
 
When property assignments are reset, this means that entities will have the default 
properties , and all staging assignment (ie. excavation and support sequencing etc.) will be 
reset. 
 
NOTE: The Reset Assign options only reset property assignments (ie. assignments made 
through the use of the Assign Properties option). The actual properties which you have 
defined with the Define options are NOT affected and will NOT be reset. 
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Selecting 
For many options in PHASE2 you are required to select entities on the screen, for example: 
 

• Boundaries, for editing, applying tractions, restraints, liners, etc. 
• Bolts, for editing 
• Vertices, for editing 

 
Here are some useful tips to remember when selecting: 
 
General Rules 

1. When an entity is selected, it will temporarily change colour or line style, to indicate 
that it is selected. For example, boundaries change to dashed red lines when selected. 

2. IMPORTANT!!! Selection works as a toggle. That is, whenever an entity is selected, it 
can be de-selected by simply re-selecting it with the left mouse button. This is useful 
any time that you select an entity by accident, that you did not intend to select. 

3. The toggle described in step 2 above, only applies when selecting individual entities 
with the left mouse button. If you are selecting entities with a window (see below), they 
will NOT be de-selected if you re-select them with a window. You can always de-select 
them individually with the left mouse button, even if they were originally selected with 
a window. 

 
Selecting with a Window 
Entities can be selected by drawing a rectangular window around them with the mouse. This 
is useful for selecting multiple entities. 

1. When selecting entities with a window, there are two modes available:  
• regular WINDOW mode, which requires that entities must be COMPLETELY within 

the window to be selected.  
• CROSSING window mode, which will select entities within or crossing the window 

(not applicable to vertices, see note below).  
• The two window modes can be accessed with the right-mouse button, or by typing w 

(for a regular window) or c (for a crossing window) in the prompt line while you are 
selecting. You will find the two window selecting modes to be useful in different 
situations, experiment with them to see how they work. 

NOTE: the CROSSING window mode is only applicable when selecting line segments, or 
entire entities. It is NOT applicable if you are selecting vertices (for moving or deleting). 

 
Selecting All Entities 
To select ALL entities of a given type (eg. all loads, or all bolts), here are some useful 
shortcuts:  
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• right-click the mouse, and choose Select All from the popup menu 
• type the asterisk " * " character in the prompt line, followed by Enter 
• draw a selection window (see above) around all entities to be selected. 

 
Selection Filter 
The Selection Filter allows the user to choose which boundary types can be selected for 
editing. By default, all boundaries are selectable. The main purpose of the Selection Filter 
is to allow the user to select boundaries with a window, but filter out the selecting of some 
boundary types which may be within the window. See the Selection Filter topic for more 
information. 
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Right-click Menus 
Whenever you are using the mouse in PHASE2, the right mouse button will always bring up 
a context menu with option(s) appropriate to the action being performed. 
 
Default right mouse 
When no action is being performed, the default right-click menu makes available: 
Zoom Window  
Zoom Mouse  
Zoom All  
Pan  
Display Options  
 
When using any option in PHASE2, always check what is available in the right-mouse menu, 
you may find the options very useful and time saving. For example: 

• After selecting entities, the right mouse button always makes available Done Selection.  
• For other options, Done or Cancel is available.  
• While applying restraints , the method of applying restraints can be changed (pick by 

line segment / pick by node). 
• While entering boundaries, the snap mode can be toggled (vertex snap / grid snap / no 

snap) 
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Shortcut Keys 
The following keyboard shortcuts are available: 
 
Zoom All   F2 function key 
Zoom In   F5 function key OR Home key 
Zoom Out   F4 function key OR End key 
Zoom Excavation  F8 function key 
Pan Left  left arrow 
Pan right  right arrow 
Pan up   up arrow 
Pan down  down arrow 
Grid toggle  F7 function key 
Snap toggle  F9 function key 
Stage tabs  Page Up / Page Down keys OR Ctrl-Page Up / Ctrl-Page Down 
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